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PDF books and the information center

PDF books are provided as a convenience for printing and offline reading. For the latest information, see
the online information center.

As a set, the PDF books contain the same content as the information center. Some links within the PDF
books have been tailored for use in the information centers and may not work properly.

The PDF documentation is available within a quarter after a major release of the information center, such
as Version 7.0 or Version 7.5.

The PDF documentation is updated less frequently than the information center, but more frequently than
the Redbooks®. In general, PDF books are updated when enough changes are accumulated for the book.
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Chapter 1. Task overview of the installation and configuration
process for a stand-alone server

A stand-alone configuration consists of a single node running an application server and one daemon
server in a single z/OS® system or logical partition (LPAR). Before installing and configuring a
stand-alone server, it is useful to understand the task flow for the process.

The IBM® Business Process Manager for z/OS installation and configuration is integrated with, and
dependent on, the installation and configuration of WebSphere® Application Server for z/OS. The task is
a multiphase process that can span multiple roles, including system programmer, product administrator,
and database administrator.

To create the IBM Business Process Manager for z/OS stand-alone server environment, the default profile,
which is created when WebSphere Application Server for z/OS is installed, must be augmented into a
profile for IBM Business Process Manager for z/OS. This process adds IBM Business Process Manager for
z/OS functions to the existing WebSphere Application Server for z/OS functions.

This task overview outlines the steps that are required to start an instance of the IBM Business Process
Manager for z/OS server. The details include preinstallation steps, steps for installing IBM Business
Process Manager for z/OS, and initial configuration steps to enable the server to be started. The steps
described here apply only to an installation and configuration that are facilitated by the use of the
WebSphere Customization Toolbox application and the z/OS Profile Management Tool (zPMT).

The following diagram illustrates the high-level flow of tasks that you need to perform to create and start
a complete, customized stand-alone server. Because the process can span multiple roles, it is possible for
some of these tasks to be done in parallel.
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zPMT
AUGMENT customization definition

incremental installation:

Install WebSphere Application Server for z/OS and feature packs

Install IBM BPM for z/OS product code

Download feature-pack and product extensions

Download and install WebSphere Customization Toolbox

Use database design file?

Yes

Run any prerequisite jobs (if relevant)
Run installation job

Create database design file

Configure security
Create and configure database
Update configuration for server

Start server
Perform additional configuration

Load database with system information

Run postinstallation jobs (if relevant)
Run configuration job

Run any postconfiguration jobs (if relevant)

Process customization definition in zPMT

No

No

Yes

WebSphere Application Server configured?

Install IBM BPM for z/OS product code

Download feature-pack and product extensions

zPMT
CREATE customization definition

stacked installation:

Use database design file?

NoYes

Determine topology, skill needs, software needs, installation method
Collate customization information for configuring the environment

1. Review the planning information to determine which topology best suits your requirements, identify
your software needs, and establish whether you need to perform incremental or stacked installations.
More information: Planning for IBM Business Process Manager
Also collate the information required for configuring your stand-alone server. This information needs
to be specified when you create the customization definition in zPMT. You can use the configuration
planning spreadsheet, which is supplied, to identify the customization parameters and record your
values.
More information: “Collating customization information for configuring your environment” on page
15

2. If not already installed, download and install WebSphere Customization Toolbox (WCT) V8.0 on a
Windows or Linux workstation.
You can use WCT to install the required WebSphere Application Server for z/OS feature-pack
extensions and the IBM Business Process Manager for z/OS extension. These extension files provide
the customization parameters that you need to configure these products. You can also use zPMT,
which runs under WCT, to specify the customization values and generate customized JCL batch jobs
and other files for configuring the IBM Business Process Manager for z/OS environment.
More information: “Installing WebSphere Customization Toolbox” on page 16

3. On the z/OS file system, use System Modification Program/Extended (SMP/E) to install the
WebSphere Application Server for z/OS product code, the Feature Pack for Service Component
Architecture (SCA), and the Feature Pack for XML.
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After the product code is installed, the WebSphere Application Server for z/OS environment can
either be configured immediately, or at a later stage:
v If the WebSphere Application Server for z/OS environment is configured immediately after

installing the product code, you can later perform an incremental installation to augment the
WebSphere Application Server for z/OS environment with IBM Business Process Manager for
z/OS functions.

v If the WebSphere Application Server for z/OS environment is not configured at this point, you can
later perform a stacked installation to configure both WebSphere Application Server for z/OS and
IBM Business Process Manager for z/OS.

More information: “Installing WebSphere Application Server” on page 17
4. Use SMP/E to install the IBM Business Process Manager for z/OS product code on the z/OS system.

More information: “Loading the product code from the installation media to the z/OS system” on
page 18

5. Download the feature-pack extensions and the IBM Business Process Manager for z/OS extension
from the z/OS system to a directory on the WCT workstation. These extensions provide
supplementary customization parameters.
More information: “Downloading the extension files and sample customization definition response
files” on page 22

6. Use zPMT to define the customization values for the stand-alone server. The main points to consider
are as follows:
v If the WebSphere Application Server for z/OS environment is already configured, perform an

incremental installation, specifying the additional parameters that are required for configuring IBM
Business Process Manager for z/OS.
More information: “Installing IBM Business Process Manager for z/OS (incremental installation
using zPMT)” on page 31

v If the WebSphere Application Server for z/OS environment is not yet configured, perform a
stacked installation in a single pass through zPMT, specifying the customization values for
WebSphere Application Server for z/OS, the feature packs, and IBM Business Process Manager for
z/OS.
More information: “Installing IBM Business Process Manager for z/OS (stacked installation using
zPMT)” on page 23

v Determine whether you want to define your database configuration in zPMT, or whether you
want to use a design file to define the database configuration. A database design file provides
more flexibility for defining the configuration settings for individual database components, and
can be generated by running the database design tool in the z/OS system.
More information: Generating a design file and DDL files for the database tables

zPMT records your customization settings in a customization definition response file and also
generates instructions that you can use to configure the target z/OS system.

7. Using zPMT, process the customization definition to generate an augmentation response file,
customized JCL jobs, and other data files, and to upload them to your target z/OS system.
More information: “Installing IBM Business Process Manager for z/OS (incremental installation using
zPMT)” on page 31 and “Installing IBM Business Process Manager for z/OS (stacked installation
using zPMT)” on page 23

8. For a stacked installation, use the instructions generated in zPMT to perform manual configuration
updates, and to run the prerequisite jobs to create and configure the WebSphere Application Server
for z/OS profile. Then run the IBM Business Process Manager for z/OS installation job to enable the
product for use.
For an incremental installation, run the installation job to enable IBM BPM for z/OS for use.
More information: “Installing IBM Business Process Manager for z/OS (incremental installation using
zPMT)” on page 31 and “Installing IBM Business Process Manager for z/OS (stacked installation
using zPMT)” on page 23
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9. If you did not define the database configuration in zPMT, use the database design tool to generate
the database design file in the z/OS system. This tool also generates Data Definition Language
(DDL) scripts, which you can later use to create the DB2® database objects for the various IBM
Business Process Manager for z/OS components.
More information: Generating a design file and DDL files for the database tables

10. Follow the instructions generated in zPMT to run the configuration job to augment WebSphere
Application Server for z/OS with IBM Business Process Manager for z/OS functions.
The configuration job requires input from the augmentation response file that is automatically
generated when you process a customization definition in zPMT.
More information: Configuring a stand-alone application serving environment using zPMT-generated
jobs

11. Complete your security configuration by updating the default federated repositories configuration to
include the RACF user registry bridge. You can do this by running a script that is supplied with the
product code.
More information: Configuring security

12. Create the database and populate it with objects by using the DDL that was created earlier.
More information: Creating and configuring the databases

13. Customize properties, such as port numbers, for the server. You can do this by running another
script that is supplied with the product code.
More information: Updating the configuration values for cluster members or stand-alone servers

14. Run the bootstrap utility to load the database with system information.
More information: Loading the database with system information

15. Start the stand-alone server, as documented in the customization instructions.
More information: Starting the server and verifying the installation

When the initial configuration of IBM Business Process Manager for z/OS is complete, you can perform
additional tasks to configure the components and administer the system.
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Chapter 2. Task overview of the installation and configuration
process for a network deployment environment

A network deployment configuration contains a deployment manager server in one node, and one or
more managed nodes in which application servers can be created. The managed nodes must be federated
into the deployment manager cell, to allow the application servers to be created and administered by the
deployment manager.

Before installing and configuring a network deployment environment, it is useful to understand the task
flow for the process.

The IBM Business Process Manager for z/OS installation and configuration is integrated with, and
dependent on, the installation and configuration of WebSphere Application Server for z/OS. The task is a
multiphase process that can span multiple roles, including system programmer, product administrator,
and database administrator.

To create the IBM Business Process Manager for z/OS network deployment environment, the default
deployment manager profile, which is created when WebSphere Application Server for z/OS is installed,
must be augmented into a profile for IBM Business Process Manager for z/OS. This process adds IBM
Business Process Manager for z/OS functions to the existing WebSphere Application Server for z/OS
functions. The default WebSphere Application Server for z/OS profile for each unmanaged node in the
network deployment environment must also be augmented into a profile for IBM Business Process
Manager for z/OS.

This task overview outlines the steps that are required to set up a single cluster topology. The details
include preinstallation steps, and steps for installing and configuring IBM Business Process Manager for
z/OS, creating and configuring the database, and setting up the deployment environment. The steps
described here apply to an installation and configuration that are facilitated by the use of the WebSphere
Customization Toolbox application and the z/OS Profile Management Tool (zPMT).

The following diagram illustrates the high-level flow of tasks that you need to perform to create and start
a cluster in a network deployment environment. Because the process can span multiple roles, it is
possible for some of these tasks to be done in parallel.
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zPMT
AUGMENT customization definition

incremental installation:

Install WebSphere Application Server for z/OS and feature packs

Install IBM BPM for z/OS product code

Download feature-pack and product extensions

Download and install WebSphere Customization Toolbox

Use database design file?

Yes

Run any prerequisite jobs (if relevant)
Run installation job

Create database design file

Run postinstallation jobs (if relevant)
Run configuration job

Run any postconfiguration jobs (if relevant)

Process customization definition in zPMT

No

No

Yes

WebSphere Application Server configured?

Install IBM BPM for z/OS product code

Download feature-pack and product extensions

zPMT
CREATE customization definition

stacked installation:

Use database design file?

NoYes

Determine topology, skill needs, software needs, installation method
Collate customization information for configuring the environment

i) Configure security
ii)
iii)
iv)
v)

Create and configure database
Start deployment manager server
Federate empty nodes into cell
Create deployment environment

vi) Update configuration of cluster members
vii)
viii)
ix)

Load database with system information
Start cluster

Perform additional configuration

1. Review the planning information to determine which topology best suits your requirements, identify
your software needs, and establish whether you need to perform incremental or stacked installations.
More information: Planning for IBM Business Process Manager
Also collate the information required for configuring your deployment manager server and empty
managed nodes. This information needs to be specified when you create the customization definition
in zPMT. You can use the configuration planning spreadsheet, which is supplied, to identify the
customization parameters and record your values.
More information: “Collating customization information for configuring your environment” on page
15

2. If not already installed, download and install WebSphere Customization Toolbox (WCT) V8.0 on a
Windows or Linux workstation.
You can use WCT to install the required WebSphere Application Server for z/OS feature-pack
extensions and the IBM Business Process Manager for z/OS extension. These extension files provide
the customization parameters that you need to configure these products. You can also use zPMT,
which runs under WCT, to specify the customization values and generate customized JCL batch jobs
and other files for configuring the IBM Business Process Manager for z/OS environment.
More information: “Installing WebSphere Customization Toolbox” on page 16

3. On the z/OS file system, use System Modification Program/Extended (SMP/E) to install the
WebSphere Application Server for z/OS product code, the Feature Pack for Service Component
Architecture (SCA), and the Feature Pack for XML.
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After the product code is installed, the WebSphere Application Server for z/OS environment can
either be configured immediately, or at a later stage:
v If the WebSphere Application Server for z/OS environment is configured immediately after

installing the product code, you can later perform an incremental installation to augment the
WebSphere Application Server for z/OS environment with IBM Business Process Manager for
z/OS functions.

v If the WebSphere Application Server for z/OS environment is not configured at this point, you can
later perform a stacked installation to configure both WebSphere Application Server for z/OS and
IBM Business Process Manager for z/OS.

More information: “Installing WebSphere Application Server” on page 17
4. Use SMP/E to install the IBM Business Process Manager for z/OS product code on the z/OS system.

More information: “Loading the product code from the installation media to the z/OS system” on
page 18

5. Download the feature-pack extensions and the IBM Business Process Manager for z/OS extension
from the z/OS system to a directory on the WCT workstation. These extensions provide
supplementary customization parameters.
More information: “Downloading the extension files and sample customization definition response
files” on page 22

6. To create and configure the deployment manager server, complete the following steps:
a. Use zPMT to define the customization values for the deployment manager. The main points to

consider are as follows:
v If the WebSphere Application Server for z/OS environment is already configured, perform an

incremental installation, specifying the additional parameters that are required for configuring
IBM Business Process Manager for z/OS.
More information: “Installing IBM Business Process Manager for z/OS (incremental installation
using zPMT)” on page 31

v If the WebSphere Application Server for z/OS environment is not yet configured, perform a
stacked installation in a single pass through zPMT, specifying the customization values for
WebSphere Application Server for z/OS, the feature packs, and IBM Business Process Manager
for z/OS.
More information: “Installing IBM Business Process Manager for z/OS (stacked installation
using zPMT)” on page 23

v Determine whether you want to define your database configuration in zPMT, or whether you
want to use a design file to define the database configuration. A database design file provides
more flexibility for defining the configuration settings of the individual database components.
Note, however, that generating a database design file will involve running the database design
tool in the z/OS system, and performing manual configuration steps for each database
component.
More information: Generating a design file and DDL files for the database tables

zPMT records your customization settings in a customization definition response file and also
generates instructions that you can use to configure the target z/OS system.

b. Using zPMT, process the customization definition to generate an augmentation response file,
customized JCL jobs, and other data files, and to upload them to your target z/OS system.
More information: “Installing IBM Business Process Manager for z/OS (incremental installation
using zPMT)” on page 31 and “Installing IBM Business Process Manager for z/OS (stacked
installation using zPMT)” on page 23

c. For a stacked installation, use the instructions generated in zPMT to perform manual
configuration updates, and to run the prerequisite jobs to create and configure the WebSphere
Application Server for z/OS profile. Then run the IBM Business Process Manager for z/OS
installation job to enable the product for use.
For an incremental installation, run the installation job to enable IBM Business Process Manager
for z/OS for use.
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More information: “Installing IBM Business Process Manager for z/OS (incremental installation
using zPMT)” on page 31 and “Installing IBM Business Process Manager for z/OS (stacked
installation using zPMT)” on page 23

d. Optional: If you did not define the database configuration in zPMT, use the database design tool
to generate the database design file in the z/OS system. This tool also generates Data Definition
Language (DDL) scripts, which you can later use to create the DB2 database objects for the
various IBM Business Process Manager for z/OS components.

Note: This is a manual step that you must run either in UNIX System Services (USS), or by using
a UNIX-based terminal emulator.
More information: Generating a design file and DDL files for the database tables

e. Follow the instructions generated in zPMT to run the configuration job to augment WebSphere
Application Server for z/OS with IBM Business Process Manager for z/OS functions.
The configuration job requires input from the augmentation response file that is automatically
generated when you process a customization definition in zPMT.
More information: Configuring a network deployment environment using zPMT-generated jobs

7. To create and configure the required empty managed nodes, complete the following steps for each
node:
a. Use zPMT to define the customization values for the node. The main points to consider are as

follows:
v If the WebSphere Application Server for z/OS environment is already configured, perform an

incremental installation, specifying the additional parameters that are required for configuring
IBM Business Process Manager for z/OS.
More information: “Installing IBM Business Process Manager for z/OS (incremental installation
using zPMT)” on page 31

v If the WebSphere Application Server for z/OS environment is not yet configured, perform a
stacked installation in a single pass through zPMT, specifying the customization values for
WebSphere Application Server for z/OS, the feature packs, and IBM Business Process Manager
for z/OS.
More information: “Installing IBM Business Process Manager for z/OS (stacked installation
using zPMT)” on page 23

zPMT records your customization settings in a customization definition response file and also
generates instructions that you can use to configure the target z/OS system.

b. Using zPMT, process the customization definition to generate an augmentation response file,
customized JCL jobs, and other data files, and to upload them to your target z/OS system.
More information: “Installing IBM Business Process Manager for z/OS (incremental installation
using zPMT)” on page 31 and “Installing IBM Business Process Manager for z/OS (stacked
installation using zPMT)” on page 23

c. For a stacked installation, use the instructions generated in zPMT to perform manual
configuration updates, and to run the prerequisite jobs to create and configure the WebSphere
Application Server for z/OS profile. Then run the IBM Business Process Manager for z/OS
installation job to enable the product for use.
For an incremental installation, run the installation job to enable IBM Business Process Manager
for z/OS for use.
More information: “Installing IBM Business Process Manager for z/OS (incremental installation
using zPMT)” on page 31 and “Installing IBM Business Process Manager for z/OS (stacked
installation using zPMT)” on page 23

d. Follow the instructions generated in zPMT to run the configuration job to augment the
WebSphere Application Server for z/OS profile.
The configuration job requires input from the augmentation response file that is automatically
generated when you process a customization definition in zPMT.
More information: Configuring a network deployment environment using zPMT-generated jobs
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8. Complete your security configuration by updating the default federated repositories configuration to
include the RACF user registry bridge. You can do this by running a script that is supplied with the
product code.
More information: Configuring security

9. Create the database for the deployment manager and populate the database with objects by using
the DDL that was created earlier.
More information: Creating and configuring the databases

10. Start the deployment manager server, as documented in the customization instructions.
More information: Starting the deployment manager

11. Federate each of the empty nodes into the deployment manager cell so that you can use the
deployment manager to administer the nodes.
More information: Federating the empty node into the deployment manager cell

12. Create the deployment environment for the single cluster topology by using the Deployment
Environment wizard in the administrative console. You can import a design file to populate the
panels and specify the database design file that you want to use. After validating the configuration
in the panels, generate the cluster.
More information: Configuring servers, server clusters, and product components

13. Customize properties, such as port numbers, for the cluster members. You can do this by running
another script that is supplied with the product code.
More information: Updating the configuration values for cluster members or stand-alone servers

14. Run the bootstrap utility to load the database with system information.
More information: Loading the database with system information

15. Start the cluster from the administrative console.
More information: Starting the cluster and verifying the installation

When the initial configuration of IBM Business Process Manager for z/OS is complete, you can perform
additional tasks to configure the components and administer the system.
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Chapter 3. Installing IBM Business Process Manager

It is useful to understand how the installation process works, and to establish the required skills and
configuration data before you begin to install IBM Business Process Manager for z/OS.

IBM Business Process Manager documentation (in PDF format)
Related information:

PDF documentation
IBM Business Process Manager documentation (in PDF format)

Information roadmaps
Business process management (BPM) information roadmaps on IBM developerWorks organize
information about WebSphere Business Process Manager, WebSphere ESB, and the other products in the
portfolio.

IBM Education Assistant
Multimedia educational modules about IBM Business Process Manager, provided by IBM Education
Assistant.

Technotes
IBM Business Process Manager Support > Install. Have questions about installing your IBM Business
Process Manager product? These resources can help lead you through your product installation and
setup.

Overview
Overview tab, on product library Web page. Use this page to access announcements, data sheets, and
other general library documents related to WebSphere ESB.

Preparing to install IBM Business Process Manager for z/OS
The IBM Business Process Manager for z/OS installation and configuration includes planning activities
for IBM Business Process Manager for z/OS and for WebSphere Application Server for z/OS.

The following table outlines the planning activities that you need to complete, and provides references to
the documentation resources that can help you install and configure IBM Business Process Manager.

Task description Information center resource

Determine the system requirements. See the System requirements web page for IBM Business Process Manager.

IBM Business Process Manager for z/OS installs on top of WebSphere
Application Server for z/OS. For a list of system requirements, see Hardware
and software requirements in the WebSphere Application Server for z/OS
Information Center.

Understand security options and
prepare for securing your system.

Security options are set in WebSphere Application Server for z/OS. See
Security planning overview information in the WebSphere Application Server
for z/OS Information Center.

Plan for your performance and
monitoring systems.

See Monitoring end user response time in the WebSphere Application Server
for z/OS Information Center.

Plan and define your problem
diagnosis procedures.

See Problem diagnostic plan strategy in the WebSphere Application Server for
z/OS Information Center.
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Task description Information center resource

Consider automatic restart
management before you install
WebSphere Application Server for
z/OS.

See Automatic restart management in the WebSphere Application Server for
z/OS Information Center.

Perform planning tasks in
preparation for loading the program
materials from the installation media
onto z/OS.

For information about planning tasks associated with unloading the
WebSphere Application Server for z/OS installation media, see Planning for
installation in the WebSphere Application Server for z/OS Information
Center.

In addition to these planning activities, it is also important to understand the z/OS skill sets required for
installing IBM Business Process Manager, the differences between the stand-alone and network
deployment configuration types that you can use to deploy and run the product, and the available
installation methods.

Overview of the installation process
The installation of IBM Business Process Manager for z/OS is a two-phase process, which, at the simplest
level, involves loading the product code to the z/OS file system, and running the installation script to
install the WebSphere product definitions that enable the product for use.

As a prerequisite, WebSphere Application Server must be installed on the z/OS system.

The two-phase installation process can be summarized as follows:

Phase 1: Loading the product code from the installation media
The contents of the installation media are loaded on to the z/OS system by using System
Modification Program/Extended (SMP/E).

This first phase is the responsibility of a system programmer who plans, maintains, and controls
the use of the operating system to improve the overall productivity of an installation.

The result of completing the first phase of the installation is a read-only installation file system,
which can be a z-Series File System (zFS) or Hierarchical File Structure (HFS).

Phase 2: Running the installation script to enable the product for use
The zBPMPSInstall.sh installation script modifies a WebSphere Application Server configuration
to enable the product for use. You can run the script manually from UNIX System Services (USS).
You can also run the script as a JCL job, which is generated when you use the WebSphere
Customization Toolbox application to create and process a customization definition for a
stand-alone server, deployment manager, or empty managed node.

When the installation script runs, it extends the IBM Business Process Manager for z/OS features
(which were loaded into the installation file system created by SMP/E) into the WebSphere
Application Server configuration file system. The configuration file system is a writable file
system that holds customized configuration files for the configured stack of WebSphere products.
By default, the configuration file system is mounted at /WebSphere/V7R0, and contains the
application server root directories (/WebSphere/V7R0/AppServer or /WebSphere/V7R0/
DeploymentManager).

The second phase of the installation is the responsibility of a product administrator.

This phase customizes the file system as follows:
v Symbolic links are created from the WebSphere Application Server for z/OS configuration file

system to the IBM Business Process Manager for z/OS installation file system (by default,
mounted at path /usr/lpp/zBPMPS/V7R5). The symbolic links point to read-only files in the
installation file system, such as JAR files and shell scripts.
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v Apache Ant script actions are invoked to update the WebSphere Application Server
administrative console with the IBM Business Process Manager for z/OS function.

The following diagram illustrates the installation phases and the roles played by the system programmer
and the product administrator during each phase.

The product installation is complete only after both phases are performed successfully.

After completing the product installation, the WebSphere administrator can begin to configure the
product for use.

Determining your skill needs
When you assemble your project team, consider the skills you require to implement WebSphere
Application Server for z/OS and IBM Business Process Manager for z/OS. Different skill sets are required
to support basic configurations and production environments.

Documentation to support the z/OS skills described here can be found at this website: z/OS Internet
Library.

Skill set for supporting basic configurations:

The following skills are necessary to support a basic configuration:
v z/OS UNIX System Services and the z-Series File System (zFS) to set up a functional zFS and

UNIX environment
v eNetwork Communications Server (TCP/IP) or equivalent to configure connectivity for

WebSphere Application Server for z/OS clients and servers
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v Resource recovery services (RRS) to implement resource recovery services and to support
two-phase commit transactions

v Security Server (RACF®), or the security product you use to authenticate WebSphere
Application Server for z/OS clients and servers, and authorize access to resources

v Secure Sockets Layer (SSL) to enable security if required
v SMP/E and JCL
v System logger to set up log streams for RRS and the WebSphere Application Server for z/OS

error log
v Webserver to support HTTP clients if required
v Workload management (WLM)
v Java™ and WebSphere Application Server tooling to support application development and

deployment

Depending on the applications you deploy, you might also need skills to configure the resource
managers that your applications require; for example, CICS®, DB2, IMS™, and MQ skills.

Skill set for supporting production environments:

As you move your system toward a production environment, you must have working knowledge
of the following systems:
v Application Response Measurement (ARM)
v System Automation, if you have it installed, or whichever automation you prefer to use
v Sysplex, if you plan to use WebSphere Application Server for z/OS in a cell that spans systems
v Sysplex Distributor (part of eNetwork Communications Server), if you plan to create a high

availability environment
v RMF™ or other performance measurement systems

Considerations for a stand-alone configuration
Choose a stand-alone configuration to evaluate the product or to support development of applications
and services.

You must have the following configuration in place before you can create a stand-alone configuration:
v WebSphere Customization Toolbox must be installed with the required product and feature pack

extensions.
v WebSphere Application Server for z/OS must be installed as the stand-alone server.
v Your UNIX user ID must have permission to access the UNIX shell to run the installation and

configuration scripts from inside the shell. Gaining permission to access the shell involves making
modifications to your RACF profile and creating a home directory in the UNIX shell. The home
directory is where you begin a UNIX session, and where you store environment variable files that are
required to run programs. You can also use the home directory as the main directory for storing data.

v The IBM Business Process Manager for z/OS product code must be loaded onto the system from tape,
so that you can use it to install the code definitions and to configure IBM Business Process Manager for
z/OS.

You can start with a stand-alone server and then to include it into a network deployment environment by
federating the application server into a deployment manager cell. You can do so only if no other nodes
have been federated to that cell.
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Related concepts:
“Considerations for a network deployment configuration”
Choose a network deployment configuration when your production environment needs features such as
capacity, availability, scalability, and failover support.

Considerations for a network deployment configuration
Choose a network deployment configuration when your production environment needs features such as
capacity, availability, scalability, and failover support.

You must have the following configuration in place before you can create a network deployment
topology:
v WebSphere Customization Toolbox must be installed with the required product and feature pack

extensions.
v WebSphere Application Server for z/OS must be configured on the server with a deployment manager

node and an empty managed node that has not been federated to the deployment manager. It is
important that the empty managed node is not federated before you run the installation script. You
must federate the node after you have augmented it to contain IBM Business Process Manager for
z/OS configuration data.

v Your UNIX user ID must have permission to access the UNIX shell because this is where you run the
installation and configuration scripts. Providing access involves making modifications to your RACF
(security) profile and creating a home directory within the UNIX shell. The home directory is where
you begin a UNIX session, and where you store environmental variable files that are required to run
programs. You can also use the home directory as the main directory for keeping your work data.

v The IBM Business Process Manager for z/OS product code must be loaded onto the system from tape,
so that you can install the code definitions to enable the product for use and configure the product.

When configuring a deployment manager node, the following consideration applies when allocating
target data sets to hold the configuration JCL. It is possible, though not recommended, to use the same
target data sets that you might have used for a stand-alone application server node. The job names for
each configuration are very similar to one another, so if you use the same target data sets, it might be
difficult to keep the two sets of jobs separate. Therefore, create a new set of target data sets for the
deployment manager node and keep the two sets of jobs separate from one another.

It is very important that you plan your IBM Business Process Manager for z/OS configuration before you
start, especially when configuring a network deployment cell. There are many choices and you must
understand the factors that influence these choices to make the correct decisions during the installation
process.
Related concepts:
“Considerations for a stand-alone configuration” on page 14
Choose a stand-alone configuration to evaluate the product or to support development of applications
and services.

Collating customization information for configuring your environment
After you have determined your topology, collect the information that you will need to configure your
application serving environment. As part of the installation and configuration, you must specify
customization variables for WebSphere Application Server for z/OS, its feature packs, and IBM Business
Process Manager for z/OS.

A configuration planning spreadsheet is supplied, which you can use to identify the variables required
for creating and configuring the profile. This spreadsheet can be downloaded for use, as detailed in
Techdoc WP101953.
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The configuration planning spreadsheet consists of a number of worksheets, which are color-coded, and
which include comments, to assist with data entry. The spreadsheet also includes macros that can be used
to generate the following artifacts:
v Response files

You can import these files into the z/OS Profile Management Tool (zPMT) in order to generate
customization definitions, JCL batch jobs, and augmentation response files that you can use to create
and augment IBM Business Process Manager runtime environments on remote z/OS systems.

v A database design file
You can use this file to generate database scripts, which you can then run to create the DB2 database
objects for the IBM Business Process Manager components. When creating your deployment
environment, you can also choose to import the database design file into the Deployment Environment
wizard in the administrative console in order to populate the fields with your database configuration
values.

v A deployment environment design file
When creating your deployment environment, you can import this file into the Deployment
Environment wizard to populate the fields with definitions for the deployment environment that you
want to create.

If you intend to complete the zPMT windows without the benefit of an imported response file, the
configuration planning spreadsheet can serve as a useful reference for the data you need to collate before
you begin to create your customization definition for the IBM Business Process Manager for z/OS
runtime environment. The data required can span multiple roles, such as system programmer, product
administrator, and database administrator.
Related tasks:
“Creating a customization definition for a fully-customized profile” on page 25
You can define the customization parameters for WebSphere Application Server for z/OS, its feature
packs, and IBM Business Process Manager for z/OS in a single pass through zPMT. This customization
definition can then be used to create a fully-customized IBM Business Process Manager stand-alone
server, deployment manager, or empty managed node.

Installing WebSphere Customization Toolbox
You require WebSphere Customization Toolbox V8.0 to install the required feature-pack and product
extension files, and to create the response files and customized JCL jobs that can be used to tailor your
IBM Business Process Manager installation.

WebSphere Customization Toolbox (including the required profile and migration management tools) is
supported on Windows and Linux operating systems, so you require a Windows or Linux workstation on
which to download and install the toolbox.

To obtain access to the WebSphere Customization Toolbox V8.0 installation packages, you require an IBM
ID and password. If you do not already have an ID and a password, go to http://www.ibm.com and
click Register to complete the IBM registration process.

IBM Installation Manager is also required for installing WebSphere Customization Toolbox. Installation
Manager is a tool that you can use to install and maintain IBM software packages. If Installation Manager
is not yet installed on the Windows or Linux workstation, you can download the latest version of the
installation package from the Installation Manager downloads page. For more information about
installing and running Installation Manager, see the IBM Installation Manager Information Center.
1. Start Installation Manager.
2. Click File > Preferences.
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3. From the Preferences window, use the Add Repository button to configure a repository connection to
one of the following download sites where the WebSphere Customization Toolbox installation
packages are stored. To connect to these download sites, you must authenticate using your IBM ID
and password.
v http://www.ibm.com/software/repositorymanager/com.ibm.websphere.WCT.v80: Connect to this

repository to download the WebSphere Customization Toolbox version that is available with a
WebSphere Application Server for z/OS V8.0 license.

v http://www.ibm.com/software/repositorymanager/V8WASSupplementsILAN: Connect to this
repository to download the WebSphere Customization Toolbox (ILAN) version. The ILAN version is
freely available and is identical to the licensed WebSphere Customization Toolbox, but is a
no-charge, non-supported, and non-warranted version.

Tip: IBM Business Process Manager for z/OS V7.5 is compatible with WebSphere Application
Server for z/OS V7.0, but can be customized only by using WebSphere Customization Toolbox
V8.0. If you do not require and have not purchased a WebSphere Application Server for z/OS V8.0
license, connect to the WebSphere Customization Toolbox (ILAN) repository to use the ILAN
version of the toolbox.

4. Click OK to close the Preferences window.
5. Click Install to install the relevant WebSphere Customization Toolbox version. At a minimum, select

the z/OS profile and migration management tools for installation with the toolbox.
For more information about installing WebSphere Customization Toolbox, go to the WebSphere
Application Server for z/OS V8.0 Information Center, and search for WebSphere Customization Toolbox.

After you install WebSphere Customization Toolbox, you can use the z/OS Profile Management Tool to
customize your installation of IBM Business Process Manager.

Installing WebSphere Application Server
Before you can install IBM Business Process Manager for z/OS, you must install and optionally configure
WebSphere Application Server for z/OS.

The procedure for installing WebSphere Application Server differs depending on the topology that you
choose.

Stand-alone server
Creating a WebSphere Application Server stand-alone server provides you with the default profile
that you can augment with IBM Business Process Manager configuration data.

Network deployment environment
In the network deployment cell, creating a WebSphere Application Server deployment manager
creates the default WebSphere Application Server profile that you can augment with IBM
Business Process Manager functions.

One or more new empty WebSphere Application Server nodes are also required on which to
install IBM Business Process Manager. After configuring the deployment manager and empty
nodes to support IBM Business Process Manager, you can then federate the nodes into the cell.

1. Install WebSphere Application Server for z/OS. For further details, see the information about
installing the product and additional software on z/OS, and the preparatory and planning activities in
the WebSphere Application Server Version 7.0 Information Center.

2. Install the following WebSphere Application Server feature packs:
v The Feature Pack for XML. For more information, see the Feature Pack for XML documentation.
v The Feature Pack for Service Component Architecture (SCA), including the Service Data Objects

(SDO) feature, which is mandatory for IBM Business Process Manager. For more information, see
the Feature pack for SCA documentation.
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Configure WebSphere Application Server for z/OS application serving environments for your z/OS target
systems. For further details, see the information about configuring the WebSphere Application Server for
z/OS product after installation, in the WebSphere Application Server Version 7.0 Information Center.

Next, install the IBM Business Process Manager product code into the configured WebSphere Application
Server environments.

Note: It is not mandatory for the WebSphere Application Server for z/OS environment to be configured
before you install the IBM Business Process Manager product code. The following installation options are
available for IBM Business Process Manager:
v If the WebSphere Application Server environment is configured before you install the IBM Business

Process Manager product code, you can use the incremental installation method to augment the
WebSphere Application Server profile with IBM Business Process Manager functions.

v If the WebSphere Application Server environment is not configured before you install the IBM Business
Process Manager product code, you can use the stacked installation method to configure WebSphere
Application Server and the feature packs, and to augment the WebSphere Application Server profile
with IBM Business Process Manager functions.

Related tasks:
“Loading the product code from the installation media to the z/OS system”
The product code for IBM Business Process Manager for z/OS is installed using either an IBM SystemPac
or ServerPac, or an IBM Custom-Built Product Delivery Option (CBPDO).
“Installing IBM Business Process Manager for z/OS (incremental installation using zPMT)” on page 31
The incremental installation method enables you to define and process the WebSphere Application Server
configuration, feature-pack configurations, and IBM Business Process Manager configuration separately in
zPMT. Use this installation method if the WebSphere Application Server environment is already
configured and you want to augment the default profile with IBM Business Process Manager functions.
“Installing IBM Business Process Manager for z/OS (stacked installation using zPMT)” on page 23
Use the stacked installation method to collectively define and process customization parameters for
WebSphere Application Server, the feature packs, and IBM Business Process Manager in a single pass
through the z/OS Profile Management Tool (zPMT). A single set of instructions and a single set of jobs
are generated to create the fully-customized IBM Business Process Manager application server,
deployment manager, or empty managed node profile.
“Installing IBM Business Process Manager for z/OS (incremental installation without using zPMT)” on
page 39
The ability to perform an incremental installation without using WebSphere Customization Toolbox and
zPMT is retained in this version of IBM Business Process Manager for z/OS. You can use this installation
method if the WebSphere Application Server environment is already configured and you want to
augment the default profile with IBM Business Process Manager functions.

Loading the product code from the installation media to the z/OS
system
The product code for IBM Business Process Manager for z/OS is installed using either an IBM SystemPac
or ServerPac, or an IBM Custom-Built Product Delivery Option (CBPDO).

In a z/OS environment, loading the product code from the installation media on to the system is usually
the responsibility of a system programmer.
v Using an IBM SystemPac or ServerPac. An IBM SystemPac or ServerPac consists of loadable product

libraries and corresponding SMP/E data sets. The instructions for how to load the product code using
a SystemPac or ServerPac are supplied with the SystemPac or ServerPac.

v Using an IBM CBPDO. A CBPDO contains SMP/E relative files and maintenance for one or more
products. The instructions for how to load the product code using a CBPDO are supplied in the IBM
Business Process Manager Program Directory.
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After the product code is loaded from the installation media and the product data sets are defined on the
system, the product administrator can perform the second phase of the installation process, which enables
the product for use. The second phase includes creating one or more customization definitions,
generating customized JCL jobs, and running the installation script.
Related tasks:
“Downloading the extension files and sample customization definition response files” on page 22
After loading the product code to the target z/OS system, assemble all the component files that you will
need to complete the installation process for IBM Business Process Manager for z/OS.
“Installing IBM Business Process Manager for z/OS (incremental installation using zPMT)” on page 31
The incremental installation method enables you to define and process the WebSphere Application Server
configuration, feature-pack configurations, and IBM Business Process Manager configuration separately in
zPMT. Use this installation method if the WebSphere Application Server environment is already
configured and you want to augment the default profile with IBM Business Process Manager functions.
“Installing IBM Business Process Manager for z/OS (stacked installation using zPMT)” on page 23
Use the stacked installation method to collectively define and process customization parameters for
WebSphere Application Server, the feature packs, and IBM Business Process Manager in a single pass
through the z/OS Profile Management Tool (zPMT). A single set of instructions and a single set of jobs
are generated to create the fully-customized IBM Business Process Manager application server,
deployment manager, or empty managed node profile.
“Installing IBM Business Process Manager for z/OS (incremental installation without using zPMT)” on
page 39
The ability to perform an incremental installation without using WebSphere Customization Toolbox and
zPMT is retained in this version of IBM Business Process Manager for z/OS. You can use this installation
method if the WebSphere Application Server environment is already configured and you want to
augment the default profile with IBM Business Process Manager functions.

Using an IBM SystemPac or ServerPac
An IBM CustomPac (SystemPac, ServerPac or ProductPac®) is a set of preinstalled product data sets
bundled with an IBM installation dialog that is used to load the data sets to disk and perform initial
customization.

In general, SMP/E work is not required during installation of a CustomPac offering. Instead, SMP/E data
sets that correspond to the CustomPac service level are loaded onto the disk along with the product data
sets. You can still use SMP/E to install preventive and corrective service after CustomPac installation.

If you use an IBM SystemPac or ServerPac, follow the instructions in the copy of ServerPac: Installing your
Order that is distributed with your SystemPac or ServerPac.

For information about installing a SystemPac or ServerPac, see ServerPac: Using the Installation Dialog
(SA22-7815).

For further information, see the following information sources:
v Support overview (WebSphere Application Server for z/OS)
v Preventive Service Planning buckets
v IBM Software Support Center

Use the following guidelines when installing from an IBM SystemPac or ServerPac:
v Choose a product data set naming convention that allows you to keep and maintain at least two copies

of product libraries for maintenance purposes. For more information, see “Planning for product data
sets” on page 20.

v If you are installing from a driving system, make sure that the maintenance level of the target system
meets requirements for IBM Business Process Manager for z/OS.
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v When the installation is complete, make sure that the product data sets are available to your z/OS
target systems. Also ensure that the IBM Business Process Manager installation file system is mounted
at /usr/lpp/zBPMPS/V7R5 or a similar mount point of your choice on each target system.

Using an IBM CBPDO
An IBM Custom-Built Product Delivery Option (CBPDO) is a set of product tapes for one or more IBM
software products that is bundled with cumulative service. Install the products and service on your
system using SMP/E.

If you use CBPDO, follow the instructions in the copy of IBM Business Process Manager Advanced for z/OS -
Process Server: Program Directory, GI13-0553-02, which is supplied with the product.

You can download the Program Directory in PDF format from the IBM Business Process Manager for
z/OS download page at http://www.ibm.com/software/integration/business-process-manager/library/
documentation/.

The Program Directory includes instructions about how to load the product code from the installation
media to your z/OS system. The Program Directory also provides instructions about how to set up the
installation file system (using zFS or HFS) so that you can run the IBM Business Process Manager
installation script.

For further information, see the following information sources:
v Support overview (WebSphere Application Server for z/OS)
v Preventive Service Planning buckets
v IBM Software Support Center

Use the following guidelines when installing from an IBM CBPDO:
v Choose a product data set naming convention that allows you to keep and maintain at least two copies

of product libraries for maintenance purposes. For more information, see “Planning for product data
sets.”

v If you are installing from a driving system, make sure that the maintenance level of the target system
meets requirements for IBM Business Process Manager for z/OS.

v When the installation is complete, make sure that the product data sets are available to your z/OS
target systems. Also ensure that the IBM Business Process Manager installation file system is mounted
at /usr/lpp/zBPMPS/V7R5 or a similar mount point of your choice on each target system.

Planning for product data sets
The IBM Business Process Manager for z/OS product code resides in a UNIX System Services file system,
and in partitioned data sets that contain installation JCL and executable files. The default high-level
qualifier for the product data sets is BPZ.

Partitioned data set contents

The IBM Business Process Manager product data sets are divided into target data sets, which are used
when you customize and run the product, and distribution data sets, which are used to undo
maintenance and revert to an earlier level (if necessary). In the following information, bpm_hlq is used to
represent the high-level data set name qualifier for a particular set of IBM Business Process Manager for
z/OS product data sets.

IBM Business Process Manager has the following target data set:

bpm_hlq.SBPZJCL
JCL for installation jobs
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IBM Business Process Manager has the following distribution data sets:

bpm_hlq.ABPZANT
Installation file system files (ASCII)

bpm_hlq.ABPZEBCD
Installation file system files (EBCDIC)

bpm_hlq.ABPZJCL
JCL for installation jobs

See the IBM Business Process Manager for z/OS Program Directory (GI13-0553-02) for allocation
information about each target data set and distribution data set. Updates to this information are included
in the Preventive Service Planning (PSP) bucket for each release of IBM Business Process Manager for
z/OS. You can find the PSP bucket at http://www14.software.ibm.com/webapp/set2/psp/srchBroker.

Product data set naming convention

To continue to run IBM Business Process Manager for z/OS while applying maintenance, you must have
at least two copies of the product data sets: one for the running application execution environment and
one to which service is applied.

Choose a middle-level qualifier for each separate release and maintenance level of IBM Business Process
Manager for z/OS. This middle-level qualifier can reflect a very simple production or test distinction; for
example "BPZ.V7PROD.*" or "BPZ.V7TEST.*". Alternatively, the middle-level qualifier can include specific
service level information; for example "BPZ.B750FP1.*" or "BPZ.B750FP2.*".

There are several places where you must specify the product data set names, so, to avoid confusion, use
the simplest data set naming scheme that accomplishes your maintenance goals.

IBM Business Process Manager file system directories
The IBM Business Process Manager for z/OS product and installation code is stored in z/OS partitioned
data sets (the product data sets) and z/OS USS file system directories.

IBM Business Process Manager installation file system

All IBM Business Process Manager for z/OS product files are stored in the installation file system
directory and its subdirectories. The installation file system for IBM Business Process Manager is defined
when you unload the product code from the installation media and install using SMP/E (phase 1 of the
installation process). The installation file system is typically mounted read-only.

The default location of the IBM Business Process Manager installation file system is /usr/lpp/zBPMPS/
V7R5.

The location of the IBM Business Process Manager installation file system is different from the location of
the WebSphere Application Server installation file system. The default location of the WebSphere
Application Server installation file system is /usr/lpp/zWebSphere/V7R0.

The product directory and all of its subdirectories must reside in the same zSeries file system (zFS) data
set. The installation jobs and program directory assume that a data set is allocated to be used for IBM
Business Process Manager, separate from the z/OS root or version data set. The sample job to create a
zFS file system is supplied in hlq.SBPZJCL, member BPZFAZFS. This job is run during installation by
your system programmer.
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Configuration file system

Each IBM Business Process Manager for z/OS application serving environment (stand-alone application
server node or network deployment cell) has configuration files in one or more WebSphere Application
Server configuration directories. These configuration directories contain symbolic links to files in the
installation product directory.

The default location of the configuration directories varies by node type, and can be denoted by the
WAS_HOME variable, where WAS_HOME is the top directory for the WebSphere Application Server
node.

WAS_HOME represents the configuration_root/nodetype_directory location, where:
v configuration_root refers to the mount point for the configuration file system in WebSphere Application

Server. For example, /wasv7config/cell_name/node_name, for a read/write file system that was created
at /wasv7config.

v nodetype_directory refers to a unique directory for the application server, deployment manager, or
unmanaged node in the configuration file system. For example, DeploymentManager for the deployment
manager, or AppServer for each stand-alone application server or unmanaged server node.

Sample values for the WAS_HOME variable are as follows:
v /wasv7config/bbobase/bbonode/AppServer

v /wasv7config/bbocell/bbodmgr/DeploymentManager

v /WebSphere/V7T3Z1/AppServer

v /WebSphere/V7T8DM/DeploymentManager

Related information:

z/OS basic skills information center

Downloading the extension files and sample customization definition
response files
After loading the product code to the target z/OS system, assemble all the component files that you will
need to complete the installation process for IBM Business Process Manager for z/OS.

You need to download the required files from the z/OS file system:
v The extension files for the Feature Pack for Service Component Architecture (SCA), the Feature Pack

for XML, and the Service Data Objects (SDO) feature. These files extend zPMT to include the
customization parameters for the feature packs, and to enable customization instructions and jobs to be
generated for augmenting the WebSphere Application Server profile.
You must download these files.

v The extension file for IBM Business Process Manager for z/OS. This file extends zPMT to include the
customization parameters, and the ability to generate customization instructions and jobs for
augmenting the WebSphere Application Server profile with IBM Business Process Manager for z/OS
features.
You must download this file.

v The sample customization definition response files for configuring IBM Business Process Manager for
z/OS profiles. These files contain name-value parameters for configuring stand-alone server or
deployment manager profiles for both incremental and stacked installations. These files can be
imported into zPMT, and provide a good starting point for the configuration because they populate the
zPMT configuration windows with standard settings, which you can then amend as required.
Use of the sample files is optional. You can download any number of these files, as required.
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1. On the workstation where the WebSphere Customization Toolbox application is installed, create a
directory to receive the files to be downloaded.

2. Check that an FTP server is running on the z/OS system.
3. Use FTP to download the required extension files and sample response files from the z/OS file system

to the directory that you created on the WebSphere Customization Toolbox workstation.
You must download the files in binary format from the z/OS product directory where the WebSphere
Application Server for z/OS Optional Materials files are installed, and from the IBM Business Process
Manager installation file system. The default locations of these files are shown in the following table.

File type File location and name

Feature-pack extension for SCA /usr/lpp/zWebSphere_OM/V7R0/FPSCA/util/
WCT/sca.wct

Feature-pack extension for XML /usr/lpp/zWebSphere_OM/V7R0/FPXML/util/
WCT/xml.wct

Feature-pack extension for SDO /usr/lpp/zWebSphere_OM/V7R0/FPSCA/util/
WCT/sdo.wct

Extension for IBM Business Process
Manager for z/OS

/usr/lpp/zBPMPS/V7R5/util/WCT/zWBI.wct

Sample customization definition
response file for a stand-alone DB2
incremental configuration

/usr/lpp/zBPMPS/V7R5/zos.config/
ZBPMPSStandaloneDB2.WCT.responseFile

Sample customization definition
response file for a deployment
manager DB2 incremental
configuration

/usr/lpp/zBPMPS/V7R5/zos.config/
ZBPMPSDMgrDB2.WCT.responseFile

Sample customization definition
response file for a stand-alone DB2
stacked configuration

/usr/lpp/zBPMPS/V7R5/zos.config/
ZBPMPSStandaloneDB2Stacked.WCT.responseFile

Sample customization definition
response file for a deployment
manager DB2 stacked configuration

/usr/lpp/zBPMPS/V7R5/zos.config/
ZBPMPSDMgrDB2Stacked.WCT.responseFile

You can now install or import the files into zPMT, and use them to define the configuration for your
runtime environment.
Related reference:
“Sample customization definition response files” on page 54
When using the z/OS Profile Management Tool (zPMT) to create a customization definition for the IBM
Business Process Manager for z/OS runtime environment, you can import a sample customization
definition response file in order to populate the zPMT windows with standard configuration values. You
can then amend these values as you progress through the windows.

Installing IBM Business Process Manager for z/OS (stacked installation
using zPMT)
Use the stacked installation method to collectively define and process customization parameters for
WebSphere Application Server, the feature packs, and IBM Business Process Manager in a single pass
through the z/OS Profile Management Tool (zPMT). A single set of instructions and a single set of jobs
are generated to create the fully-customized IBM Business Process Manager application server,
deployment manager, or empty managed node profile.

The prerequisites for a stacked installation are that SMP/E installations of the WebSphere Application
Server product code, the feature packs, and the IBM Business Process Manager for z/OS product code
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must exist in the z/OS system. Before you can create the customization definitions for your environment,
you must also install the required product and feature-pack extensions in WebSphere Customization
Toolbox.

If you want to deploy and run applications on a stand-alone application server cell, create a
customization definition for the stand-alone server in zPMT. Then process the customization definition to
generate and upload JCL jobs and data files that you can use to perform customization tasks in the z/OS
system. Finally, run the jobs on the target z/OS system.

If you want to deploy and run applications on a network deployment cell, you must go through a
multiphase process:
v Create a customization definition for the deployment manager in zPMT. Process the customization

definition to generate and upload JCL jobs and data files that you can use to perform customization
tasks in the z/OS system. Then run the jobs on the target z/OS system.

v Next, create a customization definition for a new managed node in zPMT. Process the customization
definition to generate and upload JCL jobs and data files that you can use to perform customization
tasks in the z/OS system. Then run the jobs on the target z/OS system. Repeat this process for each
empty managed node that you want to add to the cell. (When the installation and initial configuration
tasks are complete, you can federate the application servers into your network deployment cell.)

Installing the feature-pack and product extensions for the z/OS Profile
Management Tool (zPMT)
To extend zPMT with supplementary features for creating the IBM Business Process Manager for z/OS
profile, you must install the WebSphere Application Server feature-pack extensions and the IBM Business
Process Manager for z/OS extension in WebSphere Customization Toolbox.
v Install WebSphere Customization Toolbox.
v Use SMP/E to install the WebSphere Application Server for z/OS product code, the Feature Pack for

SCA, and the Feature Pack for XML on the target z/OS system. The WebSphere Application Server
environment does not need to be configured at this stage.

v Use SMP/E to install the IBM Business Process Manager for z/OS product code on the z/OS system.
v Download the feature-pack and product extension files from the z/OS file system to the workstation

where the WebSphere Customization Toolbox application is installed.
1. Start zPMT from WebSphere Customization Toolbox:

v On Linux. Use the menus that are used to start your programs. For example, click
Linux_operating_system_menus > IBM WebSphere > WebSphere Customization Toolbox V8.0.

v On Windows. Click Start > All Programs > IBM WebSphere > WebSphere Customization
Toolbox V8.0 > Tools > Profile Management Tool for z/OS.

2. Click Help > Software Updates > Manage Extensions.
3. In the WebSphere Customization Toolbox Extensions window, install the SCA feature-pack extension

as follows:
a. Click Install.
b. In the Source Archive File window, click Browse, and navigate to the location where you

downloaded the .wct extension files.
c. Select the sca.wct file, and click Open.
d. Click Next to proceed.
e. In the Extension Summary window, click Next to install the extension, and then click Finish.

4. Repeat step 2 and step 3 to install the remaining extensions in the following order, substituting
sca.wct with the relevant file name:
a. XML feature-pack extension (xml.wct)
b. SDO feature-pack extension (sdo.wct)
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c. IBM Business Process Manager extension (zWBI.wct)
5. In the WebSphere Customization Toolbox Extensions window, click Finish. WebSphere Customization

Toolbox now needs to be restarted to complete the updates.
6. When prompted to restart WebSphere Customization Toolbox, click OK.
7. After the application restarts, verify that the extension files were installed successfully by accessing

the Welcome perspective. Under List of provided tools, select Profile Management Tool (z/OS only).
In the Welcome information for selected tool area, you should see the following list of products and
components for which customization definitions can be created:
v WebSphere Application Server for z/OS
v WebSphere Application Server Feature Pack for XML Version 1.0
v WebSphere Application Server Feature Pack for SCA Version 1.0 SDO Feature
v WebSphere Application Server Feature Pack for SCA Version 1.0
v WebSphere Enterprise Service Bus for z/OS v7.5
v IBM Business Process Manager Advanced: Process Server v7.5

You can now use zPMT to create the customization definition for the IBM Business Process Manager for
z/OS stand-alone server node, deployment manager node, or empty managed node.
Related tasks:
“Installing WebSphere Customization Toolbox” on page 16
You require WebSphere Customization Toolbox V8.0 to install the required feature-pack and product
extension files, and to create the response files and customized JCL jobs that can be used to tailor your
IBM Business Process Manager installation.
“Installing WebSphere Application Server” on page 17
Before you can install IBM Business Process Manager for z/OS, you must install and optionally configure
WebSphere Application Server for z/OS.
“Loading the product code from the installation media to the z/OS system” on page 18
The product code for IBM Business Process Manager for z/OS is installed using either an IBM SystemPac
or ServerPac, or an IBM Custom-Built Product Delivery Option (CBPDO).
“Downloading the extension files and sample customization definition response files” on page 22
After loading the product code to the target z/OS system, assemble all the component files that you will
need to complete the installation process for IBM Business Process Manager for z/OS.
“Creating a customization definition for a fully-customized profile”
You can define the customization parameters for WebSphere Application Server for z/OS, its feature
packs, and IBM Business Process Manager for z/OS in a single pass through zPMT. This customization
definition can then be used to create a fully-customized IBM Business Process Manager stand-alone
server, deployment manager, or empty managed node.

Creating a customization definition for a fully-customized profile
You can define the customization parameters for WebSphere Application Server for z/OS, its feature
packs, and IBM Business Process Manager for z/OS in a single pass through zPMT. This customization
definition can then be used to create a fully-customized IBM Business Process Manager stand-alone
server, deployment manager, or empty managed node.
v Determine your topology and collate the customization information that you need for your stand-alone

configuration or network deployment configuration.
v Install WebSphere Customization Toolbox.
v Use SMP/E to install the WebSphere Application Server for z/OS product code, the Feature Pack for

SCA, and the Feature Pack for XML on the target z/OS system.

Remember: The stacked installation method operates on the premise that the WebSphere Application
Server environment has not been configured after the initial SMP/E installation.

v Use SMP/E to install the IBM Business Process Manager for z/OS product code on the z/OS system.
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v Download the WebSphere Application Server feature-pack and IBM Business Process Manager for
z/OS extensions to the WebSphere Customization Toolbox workstation. Optionally download the
sample customization definition response files.

v Install the extensions into WebSphere Customization Toolbox.

When you create the customization definition for any IBM Business Process Manager for z/OS profile,
the customization values that you specify in the zPMT windows are saved in a set of files on the
workstation. Before you begin to define the values, you must identify a customization location (or parent
directory) in which to store the files. You can save multiple customization definitions in the same
customization location, or you can use more than one customization location if you want to separate your
customization definitions into logical groupings.

A customization definition response file is written whenever you create a customization definition. This
file contains name-value pairs of the settings that you specify in zPMT. When creating a customization
definition, you can use one of the supplied sample customization definition response files, or another
existing response file, as a shortcut, to populate the zPMT windows with similar values to those you
want to define. For maximum benefit, use a response file with a customization-definition type that
matches the definition you want to create; for example, a stacked installation of a stand-alone server.

When defining the customization values for a stand-alone server or deployment manager, you can
indicate whether you want to use a database design file to define the configuration for the database
components, or whether you want to define the database configuration in the zPMT windows:
v If you want to use a database design file, you must specify a fully qualified UNIX-style path for this

file in the z/OS system; for example, /WebSphere/V7T8DM/DeploymentManager/util/dbUtils/
bpm.advanced.nd.topology.dbDesign. If the file does not yet exist, you can specify the fully qualified
file name (with a .dbDesign file extension) and then create the file later in the z/OS system by using
the database design tool. This tool provides flexibility for the database design because you can use it to
specify different configuration values for the various database components.

Tip: Make a note of the file name and file location because you will need to specify them when you
create the database design file in the z/OS system.
If you are using a remote database, also select the option to delay the execution of the database scripts
that create the database tables. You will perform this task later.

v If you choose not to use a database design file, you must specify the database configuration properties
in the zPMT windows. With this option, you are constrained to specifying the same set of
configuration values for all the database components. If you are using a remote database, also select
the option to delay the execution of the database scripts that create the database tables. You will
perform this task later.

If you intend to connect to a Process Center repository that is installed and configured on Linux,
Windows, or UNIX, you can also use zPMT to specify the web address for accessing the Process Center;
for example, http://host_name:port/ProcessCenter. The Process Center serves as a central repository for
all processes, services, and other assets that are created in the IBM Business Process Manager authoring
environments (Process Designer and Integration Designer). For more information about installing,
configuring, and managing the Process Center repository, see The Process Center repository, Installing
and configuring IBM Business Process Manager Advanced, and Authoring with IBM Business Process
Manager.
1. Start zPMT in the WebSphere Customization Toolbox application (if not already started):

v On Linux. Use the menus that are used to start your programs. For example, click
Linux_operating_system_menus > IBM WebSphere > WebSphere Customization Toolbox V8.0.
Then click Profile Management Tool to open the Profile Management Tool perspective.

v On Windows. Click Start > All Programs > IBM WebSphere > WebSphere Customization
Toolbox V8.0 > Tools > Profile Management Tool for z/OS.
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You must now specify a new or existing customization location in which to save your customization
definition files. The customization location directory can be on a local or network drive, and the
operating system must recognize the drive and have access to it.

2. In the Customization Locations view, click Add.
3. In the Add Customization Location window, choose either of the following options:

v Add an existing customization location. Specify the directory path if you want to add an existing
customization location to the list of locations you can access in zPMT. This option is useful for
sharing customization locations across installations of WebSphere Customization Toolbox, and
enables you to reuse or modify previously-created customization definitions. You can also use this
option for backup purposes.

v Create a new customization location. Complete the fields as follows:

Name Enter meaningful text that you can use to identify the generated customization definition
response file and instructions in the customization location.

Version
Select 7.0 as the version of WebSphere Application Server for z/OS that will be
customized by the definitions contained in this location. The 7.0 value is the only valid
entry for this field.

Location
Specify the full directory path in which to store the customization definition files. This
directory can either be an empty directory that already exists, or a new directory to be
created.

4. Click Finish to add the customization location to your working set in zPMT. You must now define
the customization values for creating and configuring the runtime environment.

5. In the Customization Locations view, ensure that the location to which you want to save the
customization definition is selected. In the Customization Definitions view, click Create.

6. In the Environment Selection window, locate IBM Business Process Manager Advanced: Process
Server, and select the type of environment that you want to create:
v Deployment manager with IBM Business Process Manager: Process Server 7.5

v Application server with IBM Business Process Manager: Process Server 7.5

v Managed (custom) node with IBM Business Process Manager: Process Server 7.5

7. Click Next.
8. In the Customization Definition Name window, complete the fields as follows:

Customization definition name
Accept the default value or specify a unique meaningful name that you can use to identify
the customization definition in zPMT. Use alphanumeric characters for the name.

Tip: This value is also used to construct a subdirectory name in the customization location,
and is used as the stem of the response file name that is created in the customization
location.

Response file path name (optional)
To populate the subsequent zPMT windows with a set of preconfigured values, you can
specify the full path to a customization definition response file (of a matching or similar
profile type) that was created earlier. You can also specify one of the downloaded sample
customization definition response files:
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Table 1. Sample customization definition response files for a stacked installation

Operating system Sample file

Linux v Sample file for a stand-alone DB2 stacked configuration:
full_dir_path/ZBPMPSStandaloneDB2Stacked.WCT.responseFile

v Sample file for a deployment manager DB2 stacked configuration:
full_dir_path/ZBPMPSDMgrDB2Stacked.WCT.responseFile

Windows v Sample file for a stand-alone DB2 stacked configuration:
full_dir_path\ZBPMPSStandaloneDB2Stacked.WCT.responseFile

v Sample file for a deployment manager DB2 stacked configuration:
full_dir_path\ZBPMPSDMgrDB2Stacked.WCT.responseFile

Server runtime performance tuning setting
This field is available only if you are creating a stand-alone application server environment.
Specify the performance-tuning setting that most closely matches the type of environment in
which the application server will run:
v Select Standard as the performance setting for general-purpose usage.
v Select Production as the performance setting for a production environment where

application changes are rare and optimal runtime performance is important. The
WebSphere Application Server installation on the target z/OS system must, at a minimum,
be at the 7.0.0.11 service level.

9. Click Next.
10. Complete the rest of the windows to set up the customization definition, using the Back and Next

buttons as necessary.

Tip: To help you complete the required entries in each window, detailed help information is
included within the body of text in the windows, or as hover help when you move the cursor over a
field. If you completed the configuration worksheet earlier, you can also use it as a reference.

11. When you get to the Customization Summary window, review the details and click Create to create
the customization definition response file and HTML instructions that can be used to create and
configure the IBM Business Process Manager for z/OS stand-alone server node, deployment manager
node, or empty managed node.
These files are created in a profiles subdirectory in the specified customization location.

12. In the Customization Definition Summary window, click Finish to close the window. In the Profile
Management Tool perspective, the following details are displayed in the tab views:
v Customization Definitions: Displays an entry for the customization definition that was created.
v Customization Summary: Displays details about the customization definition name, the

configured environment type, the customization location path, and the file names for the response
file and instructions. Also displays the z/OS target data sets to which generated jobs and other
customization data will be uploaded. Notice that the customization definition response file name
has the format name.responseFile, where name is the customization definition name that you
specified earlier.

v Customization Instructions: Displays instructions for generating the customized JCL jobs.
Describes manual configuration updates that might be required on the z/OS system before you
run the jobs. Identifies the requirements of the ID under which the jobs run. Also describes the
sequence for submitting the jobs to configure WebSphere Application Server for z/OS, the Feature
Packs for SCA, SDO, and XML, and IBM Business Process Manager for z/OS.

v Customization Response File: Displays the configuration information that you specified in the
zPMT windows, as a set of name-value pairs.

You can now process the customization definition to generate customized JCL jobs and data files for the
profile, and to upload the jobs and files to the z/OS file system.
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Related tasks:
“Installing WebSphere Customization Toolbox” on page 16
You require WebSphere Customization Toolbox V8.0 to install the required feature-pack and product
extension files, and to create the response files and customized JCL jobs that can be used to tailor your
IBM Business Process Manager installation.
“Installing WebSphere Application Server” on page 17
Before you can install IBM Business Process Manager for z/OS, you must install and optionally configure
WebSphere Application Server for z/OS.
“Loading the product code from the installation media to the z/OS system” on page 18
The product code for IBM Business Process Manager for z/OS is installed using either an IBM SystemPac
or ServerPac, or an IBM Custom-Built Product Delivery Option (CBPDO).
“Downloading the extension files and sample customization definition response files” on page 22
After loading the product code to the target z/OS system, assemble all the component files that you will
need to complete the installation process for IBM Business Process Manager for z/OS.
“Installing the feature-pack and product extensions for the z/OS Profile Management Tool (zPMT)” on
page 24
To extend zPMT with supplementary features for creating the IBM Business Process Manager for z/OS
profile, you must install the WebSphere Application Server feature-pack extensions and the IBM Business
Process Manager for z/OS extension in WebSphere Customization Toolbox.
“Processing a customization definition for a fully-customized profile”
After you create the customization definition for a fully-customized profile, you can process the
customization definition in zPMT. This action generates customized JCL jobs and other files, and uploads
the jobs and files to target data sets on the z/OS system.
Related reference:
“Collating customization information for configuring your environment” on page 15
After you have determined your topology, collect the information that you will need to configure your
application serving environment. As part of the installation and configuration, you must specify
customization variables for WebSphere Application Server for z/OS, its feature packs, and IBM Business
Process Manager for z/OS.
“Sample customization definition response files” on page 54
When using the z/OS Profile Management Tool (zPMT) to create a customization definition for the IBM
Business Process Manager for z/OS runtime environment, you can import a sample customization
definition response file in order to populate the zPMT windows with standard configuration values. You
can then amend these values as you progress through the windows.

Processing a customization definition for a fully-customized profile
After you create the customization definition for a fully-customized profile, you can process the
customization definition in zPMT. This action generates customized JCL jobs and other files, and uploads
the jobs and files to target data sets on the z/OS system.
v Use zPMT to create the customization definition for a stand-alone application server, deployment

manager, or empty managed node for IBM Business Process Manager for z/OS.
1. Start zPMT in the WebSphere Customization Toolbox application (if not already started):

v On Linux. Use the menus that are used to start your programs. For example, click
Linux_operating_system_menus > IBM WebSphere > WebSphere Customization Toolbox V8.0.
Then click Profile Management Tool to open the Profile Management Tool perspective.

v On Windows. Click Start > All Programs > IBM WebSphere > WebSphere Customization
Toolbox V8.0 > Tools > Profile Management Tool for z/OS.

2. In the Customization Locations view, select the location of the customization definition that you want
to process.

3. In the Customization Definitions view, select the customization definition to be processed. The Type
column should have an entry of Create.
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4. Click Process.
5. In the Select Process Type window, select the Upload to target z/OS system option for your preferred

FTP method.
6. Click Next.
7. In the Upload Customization Definition window, enter information that is relevant for the selected

FTP method:
v Specify authentication details for accessing the target z/OS system.
v Specify the target work directory into which the customization data will be uploaded initially, if

using secure FTP.
v Specify the FTP or SSH server port.
v Specify a timeout period for the upload process.
v Indicate whether you want to allocate the target z/OS data sets, and enter the volume and unit for

the target data sets. The target data sets might already exist on your z/OS system, or you can use
the Profile Management Tool to allocate them.

The fields containing the names of the partitioned data sets in which the customization jobs and data
files will be stored are disabled because these values must always be the same as the target data sets
specified in the configuration. To edit these locations, you must regenerate the customization
definition.

Tip: To help you complete the entries in this window, hover help information is available when you
move the cursor over a field.

8. Click Finish.
9. When the Upload successful message is displayed, click OK.

The customized jobs, an augmentation response file, and other data files are generated, and the jobs and
files are uploaded to your z/OS system, and stored in the specified CNTL and DATA target data sets.
The augmentation response file, which is required for configuring the profile, follows the naming format
BPZRSPx where x can be:
v A for a stand alone application server node
v D for a deployment manager node
v N for a managed node

You can now follow the instructions in the Customization Instructions view to complete the installation
and configuration of IBM Business Process Manager for z/OS.
Related tasks:
“Creating a customization definition for a fully-customized profile” on page 25
You can define the customization parameters for WebSphere Application Server for z/OS, its feature
packs, and IBM Business Process Manager for z/OS in a single pass through zPMT. This customization
definition can then be used to create a fully-customized IBM Business Process Manager stand-alone
server, deployment manager, or empty managed node.

Running the installation job for a fully-customized profile
The zBPMPSInstall.sh script completes the second phase of the IBM Business Process Manager for z/OS
installation by generating symbolic links within the configuration file system, to the installation file
system. You can run the script in MVS™ by submitting the installation job that was generated for your
customization definition.
v Create a configuration definition using zPMT and use the Process action to generate customized JCL

batch jobs and to upload the jobs and other data files to the z/OS system.
v Ensure that you have administrator authority on the system so that you can run the installation job.
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For your selected profile, follow the instructions that are available in the Customization Instructions
view in the Profile Management Tool perspective, in the relevant HTML file in the customization location,
or in the CNTL data set. Before you begin, read through the customization instructions to familiarize
yourself with the required steps.
1. Complete the documented manual configuration steps in the z/OS system, to update configuration

data for your base operating system or existing subsystems.
2. Begin to submit the jobs in the order listed in the customization instructions. You must first submit

the jobs that are required to configure WebSphere Application Server for z/OS and the feature packs
on the target node.
As you progress, verify that each job runs without error by browsing the job output.

3. When you get to the step to invoke the installation executable, submit the BPZINST job. This job runs
the zBPMPSInstall.sh installation script.

4. Review the BPZINST job output to verify that the job ran without error.
If any error conditions occurred, you can also review the installation log file from USS. This file is
stored in WAS_HOME/logs/bpmps/zBPMPSInstall.log.

The WebSphere Application Server configuration now contains symbolic links to the IBM Business
Process Manager installation. The WebSphere Application Server administrative console is updated so
that you can use it to administer IBM Business Process Manager.

After verifying that the installation job ran successfully, you can move on to the configuration process. If
you chose to use a database design file in zPMT and you do not already have an existing file, you must
first use the database design tool to design your DB2 database configuration before you configure IBM
Business Process Manager for z/OS.
Related tasks:
“Creating a customization definition for a fully-customized profile” on page 25
You can define the customization parameters for WebSphere Application Server for z/OS, its feature
packs, and IBM Business Process Manager for z/OS in a single pass through zPMT. This customization
definition can then be used to create a fully-customized IBM Business Process Manager stand-alone
server, deployment manager, or empty managed node.
“Processing a customization definition for a fully-customized profile” on page 29
After you create the customization definition for a fully-customized profile, you can process the
customization definition in zPMT. This action generates customized JCL jobs and other files, and uploads
the jobs and files to target data sets on the z/OS system.

Installing IBM Business Process Manager for z/OS (incremental
installation using zPMT)
The incremental installation method enables you to define and process the WebSphere Application Server
configuration, feature-pack configurations, and IBM Business Process Manager configuration separately in
zPMT. Use this installation method if the WebSphere Application Server environment is already
configured and you want to augment the default profile with IBM Business Process Manager functions.

A separate set of instructions and jobs is generated for each customization definition that is created for
the WebSphere Application Server profile, each feature pack, and IBM Business Process Manager.

The prerequisites for an incremental installation are that SMP/E installations of the WebSphere
Application Server product code, the feature packs, and the IBM Business Process Manager for z/OS
product code must exist in the z/OS system.

In this documentation, it is assumed that the WebSphere Application Server profile for a stand-alone
server, deployment manager, or empty managed node is already configured. Therefore, the only
remaining configuration required is to set up the customization definition for augmenting the profile. To
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set up this customization definition, the IBM Business Process Manager for z/OS extension must be
installed in WebSphere Customization Toolbox. Instructions for creating and configuring WebSphere
Application Server are available in the WebSphere Application Server for z/OS Information Center.

Note: If you want to deploy and run applications on a network deployment cell, you must augment the
deployment manager and each empty managed node that you want to add to the cell. The nodes must
not have been federated into the cell prior to augmentation. (When the installation and initial
configuration tasks are complete, you can federate the application servers into your network deployment
cell.)

Installing the feature-pack and product extensions for the z/OS Profile
Management Tool (zPMT)
To extend zPMT with supplementary features for augmenting a WebSphere Application Server profile
with IBM Business Process Manager for z/OS functions, you must install the WebSphere Application
Server feature-pack extensions and the IBM Business Process Manager for z/OS extension in WebSphere
Customization Toolbox.
v Install WebSphere Customization Toolbox.
v Use SMP/E to install the WebSphere Application Server for z/OS product code, the Feature Pack for

SCA, and the Feature Pack for XML on the target z/OS system. Configure the WebSphere Application
Server environment by using the Create, Augment and Process actions in zPMT.

v Use SMP/E to install the IBM Business Process Manager for z/OS product code on the z/OS system.
v Download the feature-pack and product extension files from the z/OS file system to the workstation

where the WebSphere Customization Toolbox application is installed.
1. Start zPMT from WebSphere Customization Toolbox:

v On Linux. Use the menus that are used to start your programs. For example, click
Linux_operating_system_menus > IBM WebSphere > WebSphere Customization Toolbox V8.0.

v On Windows. Click Start > All Programs > IBM WebSphere > WebSphere Customization
Toolbox V8.0 > Tools > Profile Management Tool for z/OS.

2. Click Help > Software Updates > Manage Extensions.
3. In the WebSphere Customization Toolbox Extensions window, install the SCA feature-pack extension

as follows:
a. Click Install.
b. In the Source Archive File window, click Browse, and navigate to the location where you

downloaded the .wct extension files.
c. Select the sca.wct file, and click Open.
d. Click Next to proceed.
e. In the Extension Summary window, click Next to install the extension, and then click Finish.

4. Repeat step 2 and step 3 to install the remaining extensions in the following order, substituting
sca.wct with the relevant file name:
a. XML feature-pack extension (xml.wct)
b. SDO feature-pack extension (sdo.wct)
c. IBM Business Process Manager extension (zWBI.wct)

5. In the WebSphere Customization Toolbox Extensions window, click Finish. WebSphere Customization
Toolbox must now be restarted to complete the updates.

6. When prompted to restart WebSphere Customization Toolbox, click OK.
7. After the application restarts, verify that the extension files were installed successfully by accessing

the Welcome perspective. Under List of provided tools, select Profile Management Tool (z/OS only).
In the Welcome information for selected tool area, you should see the following list of products and
components for which customization definitions can be created:
v WebSphere Application Server for z/OS
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v WebSphere Application Server Feature Pack for XML Version 1.0
v WebSphere Application Server Feature Pack for SCA Version 1.0 SDO Feature
v WebSphere Application Server Feature Pack for SCA Version 1.0
v WebSphere Enterprise Service Bus for z/OS v7.5
v IBM Business Process Manager: Process Server v7.5

You can now use zPMT to configure the WebSphere Application Server stand-alone server node,
deployment manager node, or empty managed node with IBM Business Process Manager functions.
Related tasks:
“Installing WebSphere Customization Toolbox” on page 16
You require WebSphere Customization Toolbox V8.0 to install the required feature-pack and product
extension files, and to create the response files and customized JCL jobs that can be used to tailor your
IBM Business Process Manager installation.
“Installing WebSphere Application Server” on page 17
Before you can install IBM Business Process Manager for z/OS, you must install and optionally configure
WebSphere Application Server for z/OS.
“Loading the product code from the installation media to the z/OS system” on page 18
The product code for IBM Business Process Manager for z/OS is installed using either an IBM SystemPac
or ServerPac, or an IBM Custom-Built Product Delivery Option (CBPDO).
“Downloading the extension files and sample customization definition response files” on page 22
After loading the product code to the target z/OS system, assemble all the component files that you will
need to complete the installation process for IBM Business Process Manager for z/OS.
“Creating a customization definition for augmenting a profile”
You can use zPMT to customize a WebSphere Application Server stand-alone server, deployment
manager, or empty managed node with support for IBM Business Process Manager for z/OS.

Creating a customization definition for augmenting a profile
You can use zPMT to customize a WebSphere Application Server stand-alone server, deployment
manager, or empty managed node with support for IBM Business Process Manager for z/OS.
v Determine your topology and collate the customization information that you need for your stand-alone

configuration or network deployment configuration.
v Install WebSphere Customization Toolbox.
v Install WebSphere Application Server, which is used as a base for your IBM Business Process Manager

for z/OS configuration. Also install the Feature Packs for SCA and XML.
v Download the feature-pack extensions to the WebSphere Customization Toolbox workstation. Then

configure the WebSphere Application Server environment by using WebSphere Customization Toolbox
to create the WebSphere Application Server profile, and to augment it with the feature-pack extensions.

v Use SMP/E to install the IBM Business Process Manager for z/OS product code on the z/OS system.
v Download the IBM Business Process Manager for z/OS extension to the WebSphere Customization

Toolbox workstation. Optionally download the sample customization definition response files.
v Install the extension into WebSphere Customization Toolbox.

When you create the customization definition for augmenting the WebSphere Application Server profile,
the customization values that you specify in the zPMT windows are saved in a set of files on the
workstation. Before you begin to define the values, you must identify a customization location (or parent
directory) in which to store the files. You can save multiple customization definitions in the same
customization location, or you can use more than one customization location if you want to separate your
customization definitions into logical groupings.

A customization definition response file is written whenever you create a customization definition. This
file contains name-value pairs of the settings that you specify in zPMT. When creating a customization
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definition, you can use one of the supplied sample customization definition response files, or another
existing response file, as a shortcut, to populate the zPMT windows with similar values to those you
want to define. For maximum benefit, use a response file with a customization-definition type that
matches the definition you want to create; for example, an incremental installation of a stand-alone
server.

When defining the customization values for a stand-alone server or deployment manager, you can
indicate whether you want to use a database design file to define the configuration for the database
components, or whether you want to define the database configuration in the zPMT windows:
v If you want to use a database design file, you must specify a fully qualified UNIX-style path for this

file in the z/OS system; for example, /WebSphere/V7T8DM/DeploymentManager/util/dbUtils/
bpm.advanced.nd.topology.dbDesign. If the file does not yet exist, you can specify the fully qualified
file name (with a .dbDesign file extension) and then create the file later in the z/OS system by using
the database design tool. This tool provides flexibility for the database design because you can use it to
specify different configuration values for the various database components.

Tip: Make a note of the file name and file location because you will need to specify them when you
create the database design file in the z/OS system.
If you are using a remote database, also select the option to delay the execution of the database scripts
that create the database tables. You will complete this task later.

v If you choose not to use a database design file, you must specify the database configuration properties
in the zPMT windows. With this option, you are constrained to specifying the same set of
configuration values for all the database components. If you are using a remote database, also select
the option to delay the execution of the database scripts that create the database tables. You will
complete this task later.

If you intend to connect to a Process Center repository that is installed and configured on Linux,
Windows, or UNIX, you can also use zPMT to specify the web address for accessing the Process Center;
for example, http://host_name:port/ProcessCenter. The Process Center serves as a central repository for
all processes, services, and other assets that are created in the IBM Business Process Manager authoring
environments (Process Designer and Integration Designer). For more information about installing,
configuring, and managing the Process Center repository, see The Process Center repository, Installing
and configuring IBM Business Process Manager Advanced, and Authoring with IBM Business Process
Manager.
1. Start zPMT in the WebSphere Customization Toolbox application (if not already started):

v On Linux. Use the menus that are used to start your programs. For example, click
Linux_operating_system_menus > IBM WebSphere > WebSphere Customization Toolbox V8.0.
Then click Profile Management Tool to open the Profile Management Tool perspective.

v On Windows. Click Start > All Programs > IBM WebSphere > WebSphere Customization
Toolbox V8.0 > Tools > Profile Management Tool for z/OS.

You must now specify a new or existing customization location in which to save your customization
definition files. The customization location directory can be on a local or network drive, and the
operating system must recognize the drive and have access to it.

2. In the Customization Locations view, click Add.
3. In the Add Customization Location window, choose either of the following options:

v Add an existing customization location. Specify the directory path if you want to add an existing
customization location to the list of locations you can access in zPMT. This option is useful for
sharing customization locations across installations of WebSphere Customization Toolbox, and
enables you to reuse or modify previously-created customization definitions. You can also use this
option for backup purposes.

v Create a new customization location. Complete the fields as follows:

Name Enter meaningful text that you can use to identify the generated customization definition
response file and instructions in the customization location.
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Version
Select 7.0 as the version of WebSphere Application Server for z/OS that will be
customized by the definitions contained in this location. The 7.0 value is the only valid
entry for this field.

Location
Specify the full directory path in which to store the customization definition files. This
directory can either be an empty directory that already exists, or a new directory to be
created.

4. Click Finish to add the customization location to your working set in zPMT. You must now define
the customization values for configuring the runtime environment.

5. In the Customization Locations view, ensure that the location to which you want to save the
customization definition is selected. In the Customization Definitions view, click Augment.

6. In the Environment Selection window, select the type of environment that you want to augment:
v Management

v Application server

v Managed (custom) node

7. Click Next.
8. In the Augment Selection window, select the IBM Business Process Manager: Process Server option

and click Next.
9. In the Customization Definition Name window, complete the fields as follows:

Customization definition name
Accept the default value or specify a unique meaningful name that you can use to identify
the customization definition in zPMT. Use alphanumeric characters for the name.

Tip: This value is also used to construct a subdirectory name in the customization location,
and is used as the stem of the response file name that is created in the customization
location.

Value Pre-loading
To populate the subsequent zPMT windows with a set of preconfigured values, specify the
source for the values. You can also specify a previously-created response file, or one of the
sample customization definition response files of a matching or similar profile type:

Table 2. Sample customization definition response files for an incremental installation

Operating system Sample file

Linux v Sample file for a stand-alone DB2 incremental configuration:
full_dir_path/ZBPMPSStandaloneDB2.WCT.responseFile

v Sample file for a deployment manager DB2 incremental configuration:
full_dir_path/ZBPMPSDMgrDB2.WCT.responseFile

Windows v Sample file for a stand-alone DB2 incremental configuration:
full_dir_path\ZBPMPSStandaloneDB2.WCT.responseFile

v Sample file for a deployment manager DB2 incremental configuration:
full_dir_path\ZBPMPSDMgrDB2.WCT.responseFile

10. Click Next.
11. Complete the rest of the windows to set up the customization definition, using the Back and Next

buttons as necessary.

Tip: To help you complete the required entries in each window, detailed help information is
included within the body of text in the windows, or as hover help when you move the cursor over a
field. If you completed the configuration worksheet earlier, you can also use it as a reference.
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12. When you get to the Customization Summary window, review the details and click Augment to
create the customization definition response file and HTML instructions for augmenting the
WebSphere Application Server for z/OS stand-alone server node, deployment manager node, or
empty managed node.
These files are created in a profiles subdirectory in the specified customization location.

13. In the Customization Definition Summary window, click Finish to close the window. In the Profile
Management Tool perspective, the following details are displayed in the tab views:
v Customization Definitions: Displays an entry for the customization definition that was created.
v Customization Summary: Displays details about the customization definition name, the

configured environment type, the customization location path, and the file names for the response
file and instructions. Also displays the z/OS target data sets to which generated jobs and other
customization data will be uploaded. Notice that the customization definition response file name
has the format name.responseFile, where name is the customization definition name that you
specified earlier.

v Customization Instructions: Displays instructions for generating and running the customized JCL
job. Identifies the requirements of the ID under which the job runs.

v Customization Response File: Displays the configuration information that you specified in the
zPMT windows, as a set of name-value pairs.

You can now process the customization definition to generate the customized JCL jobs and data files for
the profile, and to upload the jobs and files to the z/OS file system.
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Related tasks:
“Installing WebSphere Customization Toolbox” on page 16
You require WebSphere Customization Toolbox V8.0 to install the required feature-pack and product
extension files, and to create the response files and customized JCL jobs that can be used to tailor your
IBM Business Process Manager installation.
“Installing WebSphere Application Server” on page 17
Before you can install IBM Business Process Manager for z/OS, you must install and optionally configure
WebSphere Application Server for z/OS.
“Loading the product code from the installation media to the z/OS system” on page 18
The product code for IBM Business Process Manager for z/OS is installed using either an IBM SystemPac
or ServerPac, or an IBM Custom-Built Product Delivery Option (CBPDO).
“Downloading the extension files and sample customization definition response files” on page 22
After loading the product code to the target z/OS system, assemble all the component files that you will
need to complete the installation process for IBM Business Process Manager for z/OS.
“Installing the feature-pack and product extensions for the z/OS Profile Management Tool (zPMT)” on
page 32
To extend zPMT with supplementary features for augmenting a WebSphere Application Server profile
with IBM Business Process Manager for z/OS functions, you must install the WebSphere Application
Server feature-pack extensions and the IBM Business Process Manager for z/OS extension in WebSphere
Customization Toolbox.
“Processing a customization definition for augmenting a profile”
After you create the customization definition to augment a WebSphere Application Server for z/OS
profile, you can process the customization definition in zPMT. This action generates customized JCL jobs
and other files, and uploads the jobs and files to target data sets on the z/OS system.
Related reference:
“Sample customization definition response files” on page 54
When using the z/OS Profile Management Tool (zPMT) to create a customization definition for the IBM
Business Process Manager for z/OS runtime environment, you can import a sample customization
definition response file in order to populate the zPMT windows with standard configuration values. You
can then amend these values as you progress through the windows.

Processing a customization definition for augmenting a profile
After you create the customization definition to augment a WebSphere Application Server for z/OS
profile, you can process the customization definition in zPMT. This action generates customized JCL jobs
and other files, and uploads the jobs and files to target data sets on the z/OS system.
v Use zPMT to create the customization definition for augmenting a WebSphere Application Server

stand-alone application server, deployment manager, or empty managed node with IBM Business
Process Manager functions.

1. Start zPMT in the WebSphere Customization Toolbox application (if not already started):
v On Linux. Use the menus that are used to start your programs. For example, click

Linux_operating_system_menus > IBM WebSphere > WebSphere Customization Toolbox V8.0.
Then click Profile Management Tool to open the Profile Management Tool perspective.

v On Windows. Click Start > All Programs > IBM WebSphere > WebSphere Customization
Toolbox V8.0 > Tools > Profile Management Tool for z/OS.

2. In the Customization Locations view, select the location of the customization definition that you want
to process.

3. In the Customization Definitions view, select the customization definition to be processed. The Type
column should have an entry of Augment.

4. Click Process.
5. In the Select Process Type window, select the Upload to target z/OS system option for your preferred

FTP method.
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6. Click Next.
7. In the Upload Customization Definition window, enter information that is relevant for the selected

FTP method:
v Specify authentication details for accessing the target z/OS system.
v Specify the target work directory into which the customization data will be uploaded initially, if

using secure FTP.
v Specify the FTP or SSH server port.
v Specify a timeout period for the upload process.
v Indicate whether you want to allocate the target z/OS data sets, and enter the volume and unit for

the target data sets. The target data sets might already exist on your z/OS system, or you can use
the Profile Management Tool to allocate them.

The fields containing the names of the partitioned data sets in which the customization jobs and data
files will be stored are disabled because these values must always be the same as the target data sets
specified in the configuration. To edit these locations, you must regenerate the customization
definition.

Tip: To help you complete the entries in this window, hover help information is available when you
move the cursor over a field.

8. Click Finish.
9. When the Upload successful message is displayed, click OK.

The customized jobs, an augmentation response file, and other data files are generated, and the jobs and
files are uploaded to your z/OS system, and stored in the specified CNTL and DATA target data sets.
The augmentation response file, which is required for configuring the profile, follows the naming format
BPZRSPx where x can be:
v A for a stand alone application server node
v D for a deployment manager node
v N for a managed node

You can now follow the instructions in the Customization Instructions view to complete the
configuration of IBM Business Process Manager for z/OS.
Related tasks:
“Creating a customization definition for augmenting a profile” on page 33
You can use zPMT to customize a WebSphere Application Server stand-alone server, deployment
manager, or empty managed node with support for IBM Business Process Manager for z/OS.

Running the installation job using zPMT-generated JCL
The zBPMPSInstall.sh script completes the second phase of the IBM Business Process Manager for z/OS
installation by generating symbolic links within the configuration file system, to the installation file
system. You can run the script in MVS by submitting the augmentation job that was generated for your
customization definition.
v Install the WebSphere Application Server product code and the Feature Packs for SCA and XML.
v Configure the WebSphere Application Server environment by creating the WebSphere Application

Server profile and augmenting it with the feature-pack extensions.
v Install the IBM Business Process Manager for z/OS product code on the z/OS system and install the

product extension into WebSphere Customization Toolbox.
v Use zPMT to create and process the customization definition for augmenting the WebSphere

Application Server profile with IBM Business Process Manager functions.
v Ensure that you have administrator authority on the system so that you can run the installation job.
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For your selected profile, you can follow the instructions that are available in the Customization
Instructions view in the Profile Management Tool perspective, in the relevant HTML file in the
customization location, or in the CNTL data set. Before you begin, read through the customization
instructions to familiarize yourself with the required steps.
1. Complete the documented preinstallation steps.
2. When you get to the step to invoke the installation executable, submit the BPZINST job. This job runs

the zBPMPSInstall.sh installation script.
3. Review the BPZINST job output to verify that the job ran without error.

If any error conditions occurred, you can also review the installation log file from USS. This file is
stored in WAS_HOME/logs/bpmps/zBPMPSInstall.log.

The WebSphere Application Server configuration now contains symbolic links to the IBM Business
Process Manager installation. The WebSphere Application Server administrative console is updated so
that you can use it to administer IBM Business Process Manager.

After verifying that the installation job ran successfully, you can move on to the configuration process. If
you chose to use a database design file in zPMT and you do not already have an existing file, you must
first use the database design tool to design your DB2 database configuration before you configure IBM
Business Process Manager for z/OS.
Related tasks:
“Installing WebSphere Application Server” on page 17
Before you can install IBM Business Process Manager for z/OS, you must install and optionally configure
WebSphere Application Server for z/OS.
“Creating a customization definition for augmenting a profile” on page 33
You can use zPMT to customize a WebSphere Application Server stand-alone server, deployment
manager, or empty managed node with support for IBM Business Process Manager for z/OS.
“Processing a customization definition for augmenting a profile” on page 37
After you create the customization definition to augment a WebSphere Application Server for z/OS
profile, you can process the customization definition in zPMT. This action generates customized JCL jobs
and other files, and uploads the jobs and files to target data sets on the z/OS system.

Installing IBM Business Process Manager for z/OS (incremental
installation without using zPMT)
The ability to perform an incremental installation without using WebSphere Customization Toolbox and
zPMT is retained in this version of IBM Business Process Manager for z/OS. You can use this installation
method if the WebSphere Application Server environment is already configured and you want to
augment the default profile with IBM Business Process Manager functions.

The prerequisites for an incremental installation without using zPMT are that SMP/E installations of the
WebSphere Application Server product code, the feature packs, and the IBM Business Process Manager
for z/OS product code must exist in the z/OS system.

In this documentation, it is assumed that the WebSphere Application Server profile for a stand-alone
server, deployment manager, or empty managed node is already configured and augmented with the
feature packs for SCA, SDO, and XML.

Note: If you want to deploy and run applications on a network deployment cell, you must augment the
deployment manager and each empty managed node that you want to add to the cell. The nodes must
not have been federated into the cell, prior to augmentation. (When the installation and initial
configuration tasks are complete, you can federate the application servers into your network deployment
cell.)
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To complete an incremental installation without using WebSphere Customization Toolbox and zPMT:
1. Install and configure the WebSphere Application Server for z/OS environment. For further

information, see “Installing WebSphere Application Server” on page 17.
2. Install the IBM Business Process Manager for z/OS product code. For further information, see

“Loading the product code from the installation media to the z/OS system” on page 18.
3. Run the zBPMPSInstall.sh installation script from USS to create the code definitions needed to run

IBM Business Process Manager for z/OS on a WebSphere Application Server for z/OS server. For
further information, see “Running the installation script from USS.”

Running the installation script from USS
The zBPMPSInstall.sh script completes the second phase of the IBM Business Process Manager for z/OS
installation by creating the code definitions needed to run IBM Business Process Manager for z/OS on a
WebSphere Application Server for z/OS server. You can run the zBPMPSInstall.sh script manually from
UNIX System Services (USS).

Important: If you are creating a network deployment configuration, you must run the installation script
on each of the nodes that will belong to the network deployment cell.
v Use SMP/E to install the WebSphere Application Server product code and the Feature Packs for SCA

and XML.
v Configure the WebSphere Application Server environment by creating a default profile and augmenting

it with the feature-pack extensions.
v Use SMP/E to install the IBM Business Process Manager for z/OS product code on the z/OS system.
v If you are running the installation script from TSO OMVS, ensure that the region size for the TSO user

ID is large enough to run Java (typically 150M).
v Ensure that the OMVS time limit is large enough to allow the product installation and configuration

scripts time to complete. To increase the OMVS time limit so the session will not time out, enter the
following system command:
SETOMVS MAXCPUTIME=86400

v Ensure that you have administrator authority on the system so that you can run the installation script.
1. Stop the target application server if running.
2. Back up the configuration file system on the server, so that you can restore it if necessary. For more

information, see Backing up the WebSphere Application Server for z/OS system.
3. In OMVS, switch to the administrator user ID. For example:

su wsadmin

4. Change to the directory in which you want to run the installation script. For example:
cd /usr/lpp/zBPMPS/V7R5/zos.config/bin

5. Add the current directory to your PATH so that you can run the installation script:
export PATH=.:$PATH

6. From the command prompt, run the installation script. For example:
zBPMPSInstall.sh -smproot /usr/lpp/zBPMPS/V7R5 -runtime /usr/lpp/zWebSphere/V7R0/AppServer
-install

You can optionally redirect the standard out messages to a file instead of displaying them in the
console; however, this procedure assumes that you are viewing the standard out messages while the
script runs.
Review the messages that are displayed in the console, checking that no error messages are displayed.
When the installation script has finished running, the following messages (or similar) are displayed
before you are returned to the shell prompt:
CWPIZ0256I: set up configuration complete
CWPIZ0257I: creating the symbolic links...
CWPIZ0259I: creation of symbolic links complete
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CWPIZ0260I: doing post install file updates...
CWPIZ0262I: post install updates complete
CWPIZ0263I: running Configuration Manager update...
Oct 19, 2007 4:28:16 PM com.ibm.ws390.installer.WPSInstaller
INFO: BBZWI218
Oct 19, 2007 4:38:16 PM com.ibm.ws390.installer.WPSInstaller
WARNING: BBZWI221
CWPIZ0264I: Configuration Manager update complete

If any error conditions occurred, you can also review the installation log file from USS. This file is
stored in WAS_HOME/logs/bpmps/zBPMPSInstall.log.

The WebSphere Application Server configuration now contains symbolic links to the IBM Business
Process Manager installation. The WebSphere Application Server administrative console is updated so
that you can use it to administer IBM Business Process Manager.

After verifying that the installation script ran successfully, use the database design tool to define your
database configuration, manually create an augmentation response file, and then run the IBM Business
Process Manager for z/OS configuration script.
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Chapter 4. Installation reference information

This reference section contains subtasks and supporting conceptual and reference information related to
installing IBM Business Process Manager for z/OS.

Differences between stand-alone and network deployment
configurations
A stand-alone application server cell, also known as a base application server node, is the simplest
configuration you can use to deploy and run IBM Business Process Manager for z/OS applications. A
stand-alone configuration provides a framework for a quick start or development environment, and if
you are configuring for a small environment you might find that a single server topology is all you need
to meet your requirements. However, you are probably more likely to use a network deployment
configuration because it can administer application servers that can be dispersed among multiple
sysplexes in a network environment. A network deployment configuration is intended to support
multiple application servers, which can be clustered to provide high availability and reliability.

The main differences between a stand-alone and a network deployment configuration are as follows:

Stand-alone configuration Network deployment configuration

A minimum of four address spaces are allocated for the
following processes:

v Location service daemon

v Controller

v Servant

v Control region adjunct

The maximum amount of address spaces is limited only
by resources.

A minimum of seven address spaces are allocated for the
following processes:

v Location service daemon

v Application server controller

v Application server servant

v Application server control region adjunct

v Deployment manager controller

v Deployment manager servant

v Node agent

The maximum amount of address spaces is limited only
by resources.

Each server node is in a separate administrative domain. All nodes are in the same administrative domain.

You can start and stop servers independently. Each
server has an independent, unshared JNDI namespace.

You can start and stop servers independently, however
the JNDI namespace is shared among all servers in the
cell.

Multiple servants are allowed. Multiple servants are allowed.

Clustering is not available. Clustering is available.

IBM Business Process Manager for z/OS installation media contents
The IBM Business Process Manager for z/OS components that are to be installed on z/OS systems are
supplied on a single tape or as a download package; components that are to be installed on non-z/OS
systems are supplied on DVDs.

Software supplied with IBM Business Process Manager for z/OS

The IBM Business Process Manager for z/OS package contains all the software that you need to install
and configure IBM Business Process Manager for z/OS, and to assemble and deploy applications.
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The tape, or download package, includes WebSphere Application Server for z/OS, which needs to be
installed before installing IBM Business Process Manager for z/OS. The following table lists the software
that is supplied on the tape or in the download package.

Software Description

IBM Business Process Manager for z/OS Provides the main IBM Business Process Manager for z/OS software.

WebSphere Application Server for z/OS Provides the WebSphere Application Server for z/OS software that you
must install before you install the IBM Business Process Manager for
z/OS software.

WebSphere Application Server
Application Clients

Provides a stand-alone client runtime environment for your client
applications so that you do not need to install a full instance of
WebSphere Application Server for z/OS. The application client module
is a Java Archive (JAR) file that contains a client for accessing a Java
application.

The DVDs contain optional supplemental software that provides tool support for your production and
development environments. The following table lists the software that is supplied on the DVDs.

Software Description

IBM Business Process Manager Clients Provides the WebSphere Application Server for z/OS configuration with
SOA Core and Business Process Choreographer functionality without
needing a full IBM Business Process Manager installation.

v IBM Business Process Manager 7.5 Client for Windows

v IBM Business Process Manager 7.5 Client for AIX®

v IBM Business Process Manager 7.5 Client for Solaris on SPARC

v IBM Business Process Manager 7.5 Client for Linux on x86 32/64-bit

v IBM Business Process Manager 7.5 Client for Linux on System z®

31-bit

v IBM Business Process Manager 7.5 Client for Linux on System z 64-bit

IBM Message Service Clients Provides messaging and Web services capabilities in non-Java
environments. Extends interaction between applications and IBM
Business Process Manager by using the provided clients:

v IBM Message Service Client for C/C++ extends the JMS model for
messaging to C and C++ applications.

v IBM Message Service Client for .NET enables .NET applications to
participate in JMS-based information flows.

WebSphere Application Server Edge
Components

Provides load balancing, caching, and centralized security. See the
WebSphere Application Server Edge Components web page for more
information.

WebSphere Application Server Network
Deployment V7.0 Supplements

Provides WebSphere Application Server Network Deployment functions,
licensed for use with IBM Business Process Manager.

IBM Tivoli® Access Manager Servers Provides authentication and authorization APIs and integration to help
you to secure access to business-critical applications and data that is
spread across the extended enterprise. See IBM Tivoli Access Manager
for e-business for more information.

44 Installing Business Process Manager for z/OS

http://www-01.ibm.com/software/webservers/appserv/was/library/v70/ec/index.html
http://www.ibm.com/software/tivoli/products/access-mgr-e-bus/
http://www.ibm.com/software/tivoli/products/access-mgr-e-bus/


Software Description

Rational® Agent Controller The Rational Agent Controller provides a technology for problem
determination. The Rational Agent Controller is an enhancement to the
Agent Controller from the Autonomic Computing Toolkit. Install the
Rational Agent Controller on one of the supported z/OS system
environments. Another z/OS system (perhaps an administrator
workstation) can use the Log and Trace Analyzer to establish
communication with the agent on the remote z/OS system. The
Analyzer can request a specific log file from the Rational Agent
Controller. The agent uses the appropriate log file parser to normalize
the native log to a Common Base Event format and transfers the log file
to the Log and Trace Analyzer. Create log file parsers for the Rational
Agent Controller with the Common Base Event model builder, which is
included in the Autonomic Computing Toolkit.

How to acquire IBM Business Process Manager for z/OS

You can obtain the product code in any of the following ways:
v IBM Custom-Built Product Delivery Option (CBPDO): The system programmer uses SMP/E to unload

the product code onto the z/OS system.
v IBM SystemPac or ServerPac: The system programmer copies SMP/E data sets that correspond to the

CustomPac service level onto the z/OS system.

To buy the software, contact your IBM representative or IBM reseller, or visit the IBM Business Process
Manager home page at http://www.ibm.com/software/integration/business-process-manager/ and
select the How to buy link.

Product version information
The properties/version directory in the IBM Business Process Manager for z/OS installation file system
contains important data about the product and its installed components, such as the build version and
build date.

Product information files

This information is included in WBI.product and [component].component files.

Run the historyInfo command to create a report about installed maintenance packages. The historyInfo
command creates a report on the console and also creates tracking files in the config_root/properties/
version/history directory.

Time-stamped, detailed logs record each update process in the properties/version/log directory of the
configuration_root.

This article describes the XML data files that store product version information for IBM Business Process
Manager for z/OS Version 6.0.x. By default, the document type declarations (DTDs) for these files are in
the properties/version/dtd folder of the root of the installation file system, or the server root directory.
See the Directory locations section of this topic for more information.

XML files in the properties/version directory that store version information:

platform.websphere
The existence of this file indicates that a WebSphere Application Server product is installed. An
example of the file follows:
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<?xml version="1.0" encoding="UTF-8">
<!DOCTYPE websphere PUBLIC "websphereId" "websphere.dtd"
<websphere name="IBM WebSphere Application Server" version="6.0"/>

The following XML files in the properties/version directory represent installed items and
installation events such as product edition, version, component, and build information.

WAS.product
The existence of this file indicates the particular WebSphere Application Server product
that is installed. The type of product installed is indicated by the <id> tag. Data in the file
indicates the version, build date, and build level

For example, <id>ND</id> product indicates that the installed product is WebSphere
Application Server Network Deployment. An example of the file follows:
<?xml version="1.0" encoding="UTF-8">
<!DOCTYPE websphere PUBLIC "productId" "product.dtd"
<product name name="IBM WebSphere Application Server - ND">
<id>ND</id>
<version>6.0.0version>6.0.0>
<build-info date="02/03/05" level="s0461.18"/>
</product>

WBI.product
The existence of this file indicates the particular IBM Business Process Manager for z/OS product
that is installed. The type of product installed is indicated by the <id> tag. Data in the file
indicates the version, build date, and build level

An example of the file follows:
<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE product SYSTEM "product.dtd">
<product name="IBM WebSphere Business Process Manager">
<id>WBI</id>
<version>6.2.0.0</version>
<build-info date="11/15/08" level="o0845.22"/>
</product>

Reports

After completing the installation, the WebSphere Application Server for z/OS reports will reflect the
installed IBM Business Process Manager for z/OS product. Refer to the product version information topic
in the WebSphere Application Server for z/OS information center for details.

Augmentation response file values
When you run the installation job or script that installs the IBM Business Process Manager for z/OS
product definitions, sample augmentation response files are installed in the installation file system. Copy
and edit these response files according to the configuration that you want to achieve, and pass in the
response file when you run the configuration script.

Note: The sample augmentation response files are deprecated. The preferred approach for creating an
augmentation response file is to install the supplied WebSphere Application Server feature-pack
extensions and the IBM Business Process Manager extension in WebSphere Customization Toolbox, and
then use the z/OS Profile Management Tool (zPMT) to generate the response file. Sample customization
definition response files are provided for use in zPMT. You can use these files to populate the zPMT
windows with standard customization values and then modify the values as required. For further
information, see About WebSphere Customization Toolbox and the z/OS Profile Management Tool and
Chapter 3, “Installing IBM Business Process Manager,” on page 11.
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Purpose

Augmentation response files contain keywords that you can use to configure IBM Business Process
Manager. Take a copy of the response file and make the file writeable before you start tailoring it to
match the needs of the configuration you are creating. When you have finished, save your changes.

Use the following rules and guidelines when you are working with augmentation response files:
v Do not leave any extra unreadable characters at the end of the keywords.
v Use TSO oedit or vi to edit the response file.
v Start comments on a new line. Do not start the comments to the right of the keyword.
v Start comments with a number sign (#) in column 1.
v The response file must be in EBCDIC format. If you prefer to edit the file using your workstation, use

the text format during the FTP download and upload.

There are global variables at the beginning of the response file that are referenced by other variables in
the file with the dollar sign ($). The serverName variable is an example of a variable that references a
global variable.

The following table lists the names of the sample augmentation response files that you can use to create
different IBM Business Process Manager for z/OS configurations.

Table 3. Sample augmentation response files

standAloneProfileDB2.rsp Use this file to create a stand-alone configuration using a
DB2 database. A stand-alone configuration has a single
node running an application server and one daemon
server in a single z/OS system or LPAR. Use a DB2
database for a production system.

DmgrDB2.rsp Use this file to create a deployment manager server with
a network deployment configuration using a DB2
database. A basic network deployment configuration
contains a deployment manager server in one node, and
an application server in another node. The application
server is then federated into the deployment manager
cell which allows the application server to be managed
by the deployment manager. In a network deployment
configuration, both nodes are augmented with IBM
Business Process Manager functions.

ManagedDB2.rsp Use this file to create a node with a network deployment
configuration using a DB2 database. A basic network
deployment configuration contains a deployment
manager server in one node, and an application server in
another node. The application server is then federated
into the deployment manager cell which allows the
application server to be managed by the deployment
manager. In a network deployment configuration, both
nodes are augmented with IBM Business Process
Manager functions.

The following table lists the default augmentation response file keywords that you can use to create your
IBM Business Process Manager for z/OS configuration. Many of these keywords default to appropriate
values if not set by a response file, and you do not need include all of these keywords in a response file
to produce a working installation of IBM Business Process Manager for z/OS.
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Table 4. Alphabetic list of keywords in IBM Business Process Manager for z/OS response files

-adminPassword The password for the administrative security user ID specified with the
-adminUserName keyword. This keyword is required when augmenting an
existing profile that has administrative security enabled.

-adminUserName The user ID that is used for administrative security. This keyword is required
when augmenting an existing profile that has administrative security
enabled.

-augment The augment parameter uses an augmentation template to configure a node
with IBM Business Process Manager for z/OS functions.

-bpcDbConnectionLocation The database location for the configuration of the Business Process
Choreographer. This value is used in place of the database name on the IBM
Business Process Manager data source definition. For example with a
stand-alone configuration DB2=LOC1.

-bpcDbHostName The database server host name or IP address for the configuration of the
Business Process Choreographer database.

-bpcDbJDBCClasspath The location of JDBC driver files.

-bpcDbName The database name for the configuration of the Business Process
Choreographer database.

-bpcDbProduct The database location for the configuration of the Business Process
Choreographer. For example, with a stand-alone configuration
DB2=DB2UDBOS390. Possible values for this keyword are:

v DB2_DATASERVER

v DB2_UNIVERSAL

v DB2UDBOS390

-bpcDbPassword The password for authenticating the JDBC resources for the Business Process
Choreographer.

-bpcDbSqlId The DB2 Schema qualifier used by the Business Process Choreographer. This
value is substituted in the install produced ddl/sql.

-bpcDbUser The DB2 user ID that has privileges to create and drop the Business Process
Choreographer databases.

-bpcDbServerPort The port number of the Business Process Choreographer database.

-bpcDbStorageGroup The DB2 schema qualifier used by the Business Process Choreographer. This
value is substituted in the ddl/sql that is produced when installing. For
example, with a stand-alone configuration DB2=BPEDBSTO.

-bpcmqPassword The password for authenticating the MQ resources for the Business Process
Choreographer.

-bpcmqUser The user name for the configuration of resources for the Business Process
Choreographer which uses IBM Business Process Manager MQ.

-bspaceAlreadyConfigured A Boolean keyword used to specify if Business Space has already been
configured for the profile.

-bspaceAlreadyDeployed A Boolean keyword used to specify if Business Space has already been
deployed to the server.

-bspaceSchemaName The DB2 Schema qualifier used for the Business Space tables. This keyword
is substituted in the install produced ddl/sql.

-cbeServerName The name of the server where the Common Base Event Browser is
configured to run.
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Table 4. Alphabetic list of keywords in IBM Business Process Manager for z/OS response files (continued)

-cdbSchemaName The schema name of the Common Data Base. This parameter valid for all
dbTypes except for Oracle/MSSQLSERVER_DataDirect/
MSSQLSERVER_MICROSOFT. Do not use this keyword for dbTypes
DB2UDBOS390 if dbSchemaName is set. The following are the default
schema values for the databases:

v DB2_UNIVERSAL or DB2_DATASERVER is “dbUserId”

v DB2UDBOS390 is “dbUserId”

Note: You can specify a different schema for supported databases, but
Recovery table is always created using the default schema if dbType is
DB2_UNIVERSAL or DB2_DATASERVER.

-ceiAlreadyDeployed A Boolean keyword used to specify if the Common Event Infrastructure has
already been deployed to the server.

-ceiBufferPool4k The name of the 4K buffer pool for the Common Event Infrastructure. This
buffer pool must be active before the database DDL scripts can be run. This
parameter is required.

-ceiBufferPool8k The name of the 8K buffer pool for the Common Event Infrastructure. This
buffer pool must be active before the database DDL scripts can be run. This
parameter is required.

-ceiBufferPool16k The name of the 16K buffer pool for the Common Event Infrastructure. This
buffer pool must be active before the database DDL scripts can be run. This
parameter is required.

-ceiCacheSizeInMB The size of the cache in MB that will be used for transaction logs.

-ceiCreateLogin An optional parameter, which if set to true results in the creation of the login
user ID that will own the Event Service Sybase tables for the Common Event
Infrastructure.

-ceiDbInstallDir The directory where the database is installed for the Common Event
Infrastructure.

-ceiDbName The DB2 name for the Common Event Infrastructure.

-ceiDiskSizeInMB The database size in MB to be created for the Event Service. For DB2 for
z/OS, the default value is 10. If you want to specify another value it must be
greater than or equal to 10.

-ceiEventCatalogDBName The name of the event catalog database.

-ceiInstancePrefix The prefix used for the CEI instance.

-ceiFindDeviceNumber The event database creates six devices for the Common Event Infrastructure.
This keyword identifies the value of the first device number that should be
assigned to the new devices. The default value is 10 if not specified.

-ceiOverrideDataSource The keyword that indicates whether or not to remove any existing Common
Event Infrastructure service data source at the specified scope before creating
a new one. When this keyword is set to true, the command removes any
existing Common Event Infrastructure service data source at the specified
scope before creating a new one. When this keyword is set to false, the
command does not create an event service data source at the specified scope
if another event service data source is found at the same scope. The default
value is false if not specified.

-ceiOracleHome (Deprecated) The directory of the ORACLE_HOME.

-ceiSaUser The Microsoft SQL Server ID that has privileges to create tables, devices, and
caches for the Common Event Infrastructure.

-ceiSaPassword The password for the Microsoft SQL Server ID that has privileges to create
tables, devices, and caches for the Common Event Infrastructure. This
keyword is required if you specify a value for the -ceiSaUser keyword,
unless the sa user ID does not have a password.
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Table 4. Alphabetic list of keywords in IBM Business Process Manager for z/OS response files (continued)

-cellName The cell name of the profile. This value must match the LONGNAME of the
cell for the WebSphere Application Server profile that you want to augment.
The value for this keyword must not contain spaces, commas or any
characters that are not valid such as the following: /, \, *, :, ;, =, +, ?, |, <, >,
&, %, ', ", ]]&gt, #, $, ^, {, or }. A period (.) is not valid if it is the first
character.

-configureBPC The keyword that determines whether the Business Process Choreographer
sample configuration is created. If you set this keyword to true, the -dbType
keyword must be set to DB2_UNIVERSAL or DB2_DATASERVER. The
default for this keyword is true if dbType is either DB2_UNIVERSAL or
DB2_DATASERVER. Otherwise, the default is false.
Note: The Business Process Choreographer sample configuration uses its
own schema named BPEDB in the Common Database (CMNDB). The
Common Database must have been created with a page size of at least 8 K.

-configureBRM The keyword that determines whether or not to configure the business rules
manager. The default value is false.

-configureBSpace The keyword that determines whether or not to configure the Business
Space. The default value is false.

-createDefaultProfileForMigration A Boolean keyword used to specify that the server will be the target of a
version to version migration. Set this value to true when you are augmenting
a standalone server to be used as a migration target. This keyword will
prevent the creation of a duplicate CEI messaging engine.

-dbAlreadyConfigured A Boolean keyword used to specify if the database has already been
configured.

-dbAppMeUserId The user ID required for authentication if messaging engines use the
common DB.

-dbAppMePassword The password required for authentication if messaging engines use the
common DB.

-dbBPCMeUserId The user ID required for Business Process Choreographer Messaging Engine
object creation. This keyword is only valid if -configureBPC is set to true.

-dbBPCMePassword The password required for Business Process Choreographer Messaging
Engine object creation. This keyword is only valid if -configureBPC is set to
true.

-dbCeiMeUserId The user ID required for authentication if the CEI messaging engines use the
common DB.

-dbCeiMePassword The password required for authentication if CEI messaging engines use the
common DB.

-dbCommonForME The keyword that indicates whether to use the common database for the
messaging engine tables. The default value is false. If you set this keyword
to true the common database is used for the messaging engine tables which
must be manually created in the common database. See Creating the
messaging engine data stores for more information.

-dbConnectionLocation The location of the DB2 for z/OS database.

-dbCeiUserId The user ID required for authentication of the CEI database.

-dbCommonUserId The user ID required for authentication of the common database.

-dbCeiPassword The password required for authentication of the CEI database.

-dbCommonPassword The password required for authentication of the common database.

-dbCreateNew A Boolean flag to indicate whether to create a new database in which to store
the Common DB, or whether to use an existing database.
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Table 4. Alphabetic list of keywords in IBM Business Process Manager for z/OS response files (continued)

-dbDelayConfig The keyword that indicates whether to postpone table creation until after the
profile is created. Valid values are true or false. This keyword is set to false
by default. Whether you set this keyword to true or false depends on your
configuration. If you have all the necessary databases set up and ready you
can set -dbDelayConfig to true. If you do not have all the necessary
databases set up and ready you can set -dbDelayConfig to false and set up
the databases after augment.

-dbDriverType The database driver type. For Oracle databases, valid values are THIN or
OCI. For DB2 databases, valid values are 2 or 4.

-dbHostName The database server host name or IP address. The default value is localhost.

-dbJDBCClasspath The JDBC class path required for the common DB.

-dbLocation The location of the database server (database product installation root).

-dbName The name of the IBM Business Process Manager database. The default value
is CMNDB.

-dbOutputScriptDir The directory location of the output script.

-dbPassword The password required for database authentication. This keyword is required
for all databases.

-dbSchemaName The name of the database schema. This keyword is valid for dbTypes
DB2UDBOS39 and is deprecated in version 7, use the cdbSchemaName
keyword instead.

-dbServerPort The database server port number. Depending on the database you are using,
you can specify a different port number instead of the default port number
which is 446.

-dbStorageGroup The name of the storage group for the DB2 for z/OS databases.

-dbSysMeUserId The database system messaging engine user ID.

-dbSysMePassword The database system messaging engine password.

-dbSysUserId The user ID to gain access to the database.

-dbSysPassword The password to gain access to the database.

-dbType The database type. For a DB2 for z/OS database, set the value to
DB2UDBOS390.

-dbUserId The user ID that is required for database authentication. This keyword is
required for all databases.

-dmgrAdminPassword The password that gains the user administration access rights to the system
in which the deployment manager is running.

-dmgrAdminUserName The user name that gains the user administration access rights to the system
in which the deployment manager is running.
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Table 4. Alphabetic list of keywords in IBM Business Process Manager for z/OS response files (continued)

-dmgrHost The keyword that identifies the system in which the deployment manager is
running. Specify this keyword with the -dmgrPort keyword to federate an
empty node when it is created. The host name can be the long or short DNS
name or the IP address of the deployment manager system. Specifying this
optional keyword directs the configuration process to attempt to federate the
empty node into the deployment manager cell when it creates the empty
node.

This keyword is ignored when creating a deployment manager or an
application server. If you federate an empty node when the deployment
manager is not running or is not available because of security being enabled
or for other reasons, the installation indicator in the logs is INSTCONFFAIL
to indicate a complete failure. The resulting empty node is unusable. You
must move the profile directory of the empty node out of the profile
repository (the profiles installation root directory) before creating another
empty node with the same name.

If you have enabled security or changed the default JMX connector type, you
cannot federate during the configuration process. Use the addNode
command instead. The default value for this keyword is localhost. The value
for this keyword must be a properly formed host name and must not contain
spaces or characters that are not valid such as the following: *, ?, ", V, < , >, ,
, /, \, |, A connection to the deployment manager must also be available in
conjunction with the -dmgrPort keyword. For example dmgr_host_name.

-dmgrPort The keyword that identifies the SOAP port of the deployment manager.
Specify this keyword with the -dmgrHost keyword to federate an empty
node when it is created. The deployment manager must be running and
accessible. If you have enabled security or changed the default JMX
connector type, you cannot federate during the configuration process. Use
the addNode command instead. The default value for this keyword is 8879.
The port that you indicate must be a positive integer and a connection to the
deployment manager must be available in conjunction with the -dmgrHost
keyword. For example dmgr_port_number.

-enableAdminSecurity The keyword that enables administrative security during the installation
process. Possible values are:

v True - when -enableAdminSecurity is set to true you must also specify
the keywords -adminUserName and -adminPassword along with the
values for these keywords.

v False - when -enableAdminSecurity is set to false, you do not have to set
any keywords.

The default value is false.

-fileStoreForME The location of the file store for messaging engines. This keyword applies to
stand-alone server configurations only. Default value is false, cannot be set to
true when -dbCommonForME is also set to true.

-isDeveloperServer Specifies whether the server is intended for development purposes only.

-portsFile An optional keyword that specifies the path to a file that defines port
settings for the new profile.

-profileName The keyword used to augment a profile. In z/OS, there is always one and
only one profile, and that profile is always named "default" in each of the
configurations. The profile referred to here is the default profile installed and
configured during the WebSphere Application Server for z/OS installation.
The profile must not have already been federated. When augmenting the
profile, the server must not be running.
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Table 4. Alphabetic list of keywords in IBM Business Process Manager for z/OS response files (continued)

-profilePath The default profile root directory for WebSphere Application Server for
z/OS. This keyword is mandatory. The server configuration for WebSphere
Application Server for z/OS resides in a directory structure under a profiles
directory. The profile path contains the files that define the runtime
environment, such as commands, configuration files, and log files. Specify
the full path to avoid an Apache Ant scripting limitation, which can cause a
failure when federating the profile into a cell. If not specified, the augment
procedure looks up the path where the profile resides in the WebSphere
Application Server for z/OS configuration, for example:

v Stand-alone DB2: /WebSphere/V7R0/AppServer/profiles/default

v Network Deployment: /WebSphere/V7R0/DeploymentManager/profiles/
default

v Managed node in Network Deployment: /WebSphere/V7R0/AppServer/
profiles/default

-serverNameplatform The name of the platform in which the server is running.

-serverType The keyword that specifies the type of management profile. Specify DMGR
for a management profile. This keyword is required when you create a
management profile.

-soaCoreAugmentType The keyword that specifies the type of SOA core augment information.

-topologyPattern The keyword that determines the topology patterns for your deployment
manager: none (default value), CondensedSync, CondensedAsync or
Reference.

-topologyRole The keyword that indicates the function the profile will play in the
deployment environment, when you are federating a profile that has been
created. Valid values are ADT for a deployment target, Messaging for host
messaging or Support for supporting services. You can indicate one value or
more than one value, each separated by a space, for example ADT
Messaging Support or Messaging or ADT Support.

-wbidbDesign The keyword that is used to specify a single design file for all of the
components during profile creation. You must specify the fully qualified path
to the design_file.

Using augmentation response files
v Be careful when you add comments to an augmentation response file.

If you put comments in the response file, and that comment resides on the same line as a property
value, even if you precede the comment with a cross hatch character (#), the Ant script attempts to
read the comment as part of the keyword value, causing unpredictable results. For example, do not
enter comments as shown in this example:
################################################################################
# DB2 Properties
################################################################################
dbJDBCClasspath=/shared/db2810/jcc/classes # DB2 ClassPath Location
dbJDBCProperties=/u/hutch/wpswork/ # DB2JccConfiguration.properties

The correct way to add comments shown in the sample above would be as follows:
################################################################################
# DB2 Properties
################################################################################
# DB2 ClassPath Location
dbJDBCClasspath=/shared/db2810/jcc/classes
# DB2JccConfiguration.properties
dbJDBCProperties=/u/hutch/wpswork/
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Global properties

The start of the augmentation response file contains a section named GLOBAL Properties. Here is an
example:
################################################################################
# GLOBAL Properties
################################################################################
JMSUSER=ibmuser
JMSPASS=ibmuser
DBUSER=wsadmin
DBPASS=wsadmin
CONFIGSERVER=server1
DBLOCATION=LOC1

################################################################################

The GLOBAL Properties section provides a central location for common values. Common values are
displayed in multiple places in the response file because they are used by multiple components. The
GLOBAL Properties section provides a central location for these common values to help you editing
these values. For example, you can use a global property to set all the server property instances to
server1 instead of searching the response file for all instances of the property that you want to change.

Use the GLOBAL property by specifying the global keyword prefixed with the $ symbol as the value for
the subsequent property. For example, serverName=$CONFIGSERVER.

Global properties must physically appear in the response file before they are referenced by the $ symbol.

When a global property is used, it must constitute the whole value of a property. The following example
is NOT allowed:
templatePath=/usr/$USERPATH/dir

Global properties simplify the use of the override argument (-Z ) in the product configuration command
by reducing the amount of syntax on the command line.

Comments for a property display above the property, the property name and the default value are
displayed in bold text. The following is an example of a property:
################################################################################
#
# Profile name
#
# On z/OS, there is always one and only one profile and that profile is named
# default in each of the configurations.
#
# The profile referred to here is the default profile installed and
# and configured during the WebSphere Application Server for z/OS install.
#
profileName=default

Sample customization definition response files
When using the z/OS Profile Management Tool (zPMT) to create a customization definition for the IBM
Business Process Manager for z/OS runtime environment, you can import a sample customization
definition response file in order to populate the zPMT windows with standard configuration values. You
can then amend these values as you progress through the windows.

The sample customization definition response files contain parameter values that you can use to
configure a stand-alone server or deployment manager server. Sample files are not supplied for a
managed node because the values that you need to configure for the node will be specific to your z/OS
environment.
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Different sets of sample customization definition files are provided for an incremental installation and for
a stacked installation:
v The sample files for an incremental installation are for configurations where each augmentation of a

product or feature pack is performed separately. Use these sample files only for augmenting a
configured WebSphere Application Server server with IBM Business Process Manager for z/OS
functions.

v The sample files for a stacked installation are for configurations where all the augmentations are
performed in one pass through zPMT. Use these sample files for augmenting the base WebSphere
Application Server server with the feature-pack and IBM Business Process Manager for z/OS functions.

The sample customization definition response files are available in the IBM Business Process Manager for
z/OS installation file system. To use these files, you must first download them in binary format to a
directory on the workstation where the WebSphere Customization Toolbox application is installed. You
can then import the relevant sample file in zPMT, and amend the default configuration values as
necessary for your runtime environment.

The database configuration in the samples files is for a DB2 for z/OS database.

The default z/OS locations of these files are shown in the following table.

Table 5. Sample customization definition response files for a DB2 for z/OS database

File description File location and name

Response file for a stand-alone
application server - incremental
configuration

/usr/lpp/zBPMPS/V7R5/zos.config/
ZBPMPSStandaloneDB2.WCT.responseFile

Response file for a deployment
manager server - incremental
configuration

/usr/lpp/zBPMPS/V7R5/zos.config/
ZBPMPSDMgrDB2.WCT.responseFile

Response file for a stand-alone
application server - stacked
configuration

/usr/lpp/zBPMPS/V7R5/zos.config/
ZBPMPSStandaloneDB2Stacked.WCT.responseFile

Response file for a deployment
manager server - stacked
configuration

/usr/lpp/zBPMPS/V7R5/zos.config/
ZBPMPSDMgrDB2Stacked.WCT.responseFile
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Related tasks:
“Downloading the extension files and sample customization definition response files” on page 22
After loading the product code to the target z/OS system, assemble all the component files that you will
need to complete the installation process for IBM Business Process Manager for z/OS.
“Creating a customization definition for a fully-customized profile” on page 25
You can define the customization parameters for WebSphere Application Server for z/OS, its feature
packs, and IBM Business Process Manager for z/OS in a single pass through zPMT. This customization
definition can then be used to create a fully-customized IBM Business Process Manager stand-alone
server, deployment manager, or empty managed node.
“Creating a customization definition for augmenting a profile” on page 33
You can use zPMT to customize a WebSphere Application Server stand-alone server, deployment
manager, or empty managed node with support for IBM Business Process Manager for z/OS.

IBM Business Process Manager – Client
IBM Business Process Manager Advanced for z/OS is packaged with CD-ROMs that allow you to install
a IBM Business Process Manager Advanced Client on a Linux, UNIX, or Windows machine for use in a
IBM Business Process Manager Advanced for z/OS environment. A Client installation provides the IBM
Business Process Manager Advanced for z/OS configuration with SOA Core and Business Process
Choreographer functionality without the need for a full IBM Business Process Manager Advanced
installation.

Installing IBM Business Process Manager – Client interactively
You can install IBM Business Process Manager – Client interactively using the launchpad, either for a new
installation or over an existing installation of WebSphere Application Server Network Deployment.

This procedure assumes that you are starting the installation process from the launchpad application. It
also assumes that even if you are installing over an existing installation WebSphere Application Server
Network Deployment, the prerequisite base products necessary for IBM Business Process Manager –
Client installation are not installed. These include WebSphere Application Server Feature Pack for XML,
and WebSphere Application Server Feature Pack for Service Component Architecture (SCA) with the
Service Data Objects (SDO) feature.

When you start the installation process using the launchpad application and are installing the product for
the first time , the launchpad installs IBM Installation Manager (if it is not already installed), WebSphere
Application Server Network Deployment, WebSphere Application Server Feature Pack for XML,
WebSphere Application Server Feature Pack for Service Component Architecture (SCA) with the Service
Data Objects (SDO) feature, and IBM Business Process Manager – Client.

If you are installing the product over an existing installation of WebSphere Application Server Network
Deployment, the launchpad installs IBM Installation Manager and updates the repository to include that
previous installation. It then installs WebSphere Application Server Feature Pack for XML, WebSphere
Application Server Feature Pack for Service Component Architecture (SCA) with the Service Data Objects
(SDO) feature, and IBM Business Process Manager – Client
1. Start the launchpad application by navigating into the directory where you extracted the image and

entering the following command:
v On Linux and UNIX platforms: extract_directory/launchpad.sh

v On Windows platforms (from a command line): extract_directory\launchpad.exe

2. Perform one of the following tasks:
v If you are installing the IBM Business Process Manager – Client for the first time, perform step a.
v If you are installing the IBM Business Process Manager – Client over an existing installation of

WebSphere Application Server Network Deployment, then perform step b.
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a. Click one of the following entries in the left pane of the launchpad, depending on whether you
are a root/Administrator or nonroot/nonadministrative user:
1) If you are a root or an Administrator user, click New installation.
2) If you are a nonroot or a nonadministrative user, click Nonadministrative or nonroot

installation.
3) If you already have IBM Installation Manager installed, ensure that it is not running.
4) In the right pane of the launchpad, in step 1, specify the location for the WebSphere

Application Server Network Deployment installation and click Install WebSphere
Application Server.
The launchpad application performs the following tasks:
v Installs WebSphere Application Server Network Deployment into the directory you specify.
v Installs IBM Installation Manager to its default installation location, if it is not already

installed. If IBM Installation Manager is not at the required level, the launchpad application
updates it to the correct level.

v Imports WebSphere Application Server into Installation Manager automatically.

Important: This process occurs silently and can take several minutes. Do not proceed until a
message indicates a successful installation and import into Installation Manager. Instead of a
success message, you might receive one of the following messages:
v WebSphere Application Server installation failed. In this case, review the following log

file to identify the cause:
– On Linux and UNIX platforms: was_home/logs/install/log.txt

– On Windows platforms: was_home\logs\install\log.txt

If the logs directory does not exist on your system, the installation failed early in the
process. In this case, review the following log file:
– On Linux and UNIX platforms: user_home/waslogs/log.txt

– On Windows platforms: user_home\waslogs\log.txt

v WebSphere Application Server installation was successful, but there were errors
importing into Installation Manager. In this case, review the following log file to identify
the cause:
– On Linux and UNIX platforms: was_home/logs/launchpad_import.txt

– On Windows platforms: was_home\logs\launchpad_import.txt

b. Click Installation on existing WebSphere Application Server in the left pane of the launchpad.
3. In the right pane of the launchpad, in step 2, click Install IBM Business Process Manager – Client.

The launchpad application starts Installation Manager and its Install Packages wizard.
4. On the Install page of the Install Packages wizard, all recommended packages, including WebSphere

Application Server Feature Pack for XML, WebSphere Application Server Feature Pack for Service
Component Architecture (SCA) with the Service Data Objects (SDO) feature, and IBM Business
Process Manager – Client are preselected for installation. Click Next.

5. On the Install Packages wizard Licenses page, read through the license agreements and then select I
accept the terms in the license agreements. Click Next. The licenses for the feature packs are also
displayed in the panel. You accept for all the licenses.

6. On the Install Packages wizard Location page, IBM WebSphere Application Server - ND_xxxxx
(where xxxxx is the date timestamp) and the Use the existing package group radio button are
selected by default. Leave those selections as they are and click Next.

Note: The Install Packages wizard displays a message if it detects any running processes. If you see
this message, click Cancel, shut down the running processes, and begin the installation again.
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7. The Install Packages wizard checks your operating system to make sure that it meets the
prerequisites for installing IBM Business Process Manager – Client. The action you take depends on
the results of the prerequisite check:
v If the prerequisite check is successful (that is, a supported operating system is found), no message

is displayed. The installation continues on to the Install Packages wizard Features page. Proceed to
step 8.

v If the prerequisite check is not successful (for example, a supported operating system is not at the
minimum supported level), you see an error message and the installation stops. You must address
the problem described in the message before you can install IBM Business Process Manager –
Client.

v If you are at a higher major release of a supported operating system, or the operating system itself
is not on the supported list, you might encounter a warning. You can continue with the
installation, but the installation or product operation might not succeed until you apply
maintenance.
If you see such a warning, go to the product support Web pages and obtain the latest maintenance
packages to apply after installation. Refer to the documentation for non-IBM prerequisite and
corequisite products to learn how to migrate to their supported versions.

8. On the Install Packages wizard Features page, accept the default selections and click Next.
9. Review the summary information. If the summary information is incorrect, click Back to change

your selections.
10. Click Install. When the installation is complete, a page displays the status of the installation and

which packages have been successfully installed.

Important: This process can take several minutes. Do not proceed until this page appears.
11. To launch the Profile Management Tool, leave the Profile Management Tool radio button selected.

Otherwise, select the radio button for None.
12. Click Finish.
13. Close Installation Manager.

IBM Business Process Manager – Client is installed.

You must define a stand-alone server profile or a deployment manager in the Profile Management Tool or
using the manageprofiles command. Only profiles created with the Profile Management Tool or
manageprofiles command can be used in production.

Installing IBM Business Process Manager – Client silently
You can install the IBM Business Process Manager – Client product package in silent installation mode.
When you install in silent mode, the user interface is not available. Instead, you use a response file to
input the commands that are required to install the product package. This procedure assumes that you
might or might not have existing installations of the prerequisite base products necessary for IBM
Business Process Manager – Client installation. These prerequisite products include WebSphere
Application Server Network Deployment, Installation Manager, WebSphere Application Server Feature
Pack for XML, and WebSphere Application Server Feature Pack for Service Component Architecture
(SCA) with the Service Data Objects (SDO) feature.

Before you can install IBM Business Process Manager – Client, you must review the list of prerequisites
for installing the product.

You start the installation process by running the or script, which you edit. The script performs some or
all the following tasks:
v Installs WebSphere Application Server Network Deployment.
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v Installs IBM Installation Manager if it is not already installed or updates it to the appropriate level if it
is.

v Imports WebSphere Application Server Network Deployment into Installation Manager.
v Installs the required base products and IBM Business Process Manager – Client using a response file

that you create.
v Automatically configures the installation with the location of the repository that contains the product

packages.
1. Locate default response file that you will use to install the required base products and IBM Business

Process Manager – Client.
The response file name and directory are listed here:
v On Linux and UNIX platforms: DVD_root or extract_root/responsefiles/wbi/

template_response.xml

v On Windows platforms: DVD_root or extract_root\responsefiles\wbi\template_response.xml

2. Edit the response file. Modify parameters as directed in the text of the response file template.
3. The script file is located in the same directory as the response file:

v On Linux and UNIX platforms: DVD_root or extract_root/responsefiles/wbi/run_templates

v On Windows platforms: DVD_root or extract_root\responsefiles\wbi\run_template.bat

4. Edit the script, modifying parameters as directed in the text of the script. Comment out any
parameters not needed for your installation. For example, comment out the parameter to install
WebSphere Application Server Network Deployment if you already have it installed on your system
and intend to install IBM Business Process Manager – Client on top of it.

5. Run the run_templates script.

The run_templates script reads the response file, installs any required prerequisites and IBM Business
Process Manager – Client writes a log file to the directory you specified. See Installation and profile
creation log files.

You must define a stand-alone server profile or a deployment manager in the Profile Management Tool or
using the manageprofiles command. Only profiles created with the Profile Management Tool or
manageprofiles command can be used in production.
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